
Open!Info Manager Help Contents

Click one of the topics below to find more information on working with Open!Info Manager.

Menus
File Menu
Edit Menu
Mode Menu
Page Menu
Template Menu
Media Menu
Properties Menu
Window Menu
Help Menu
Popup Menus

Windows
Summary Window
Diagram Window
Template Window
Page Window
Media View Window

Other topics
Toolbar
Status Bar
Selection Dialog Boxes
Media Selection Dialog Boxes
Movement Button Controls
Display Media Controls
Behavior Button Controls
Player Button Controls
Text Overlay Controls
List Button Controls
Launch Button Controls
Control Colors
Control Fills
Layered Controls
Exiting a Preview
Keyboard Shortcuts
Open!Info Reader



File Menu

The File menu provides commands for working with presentations and backup files, as well as for 
clearing the database and exiting Open!Info Manager.
New
Open
Delete
Save
Save As
Close
Publish
Preview
Create Backup
Load Backup
Clear All
Exit



Edit Menu

The Edit menu provides commands for working with controls, as well as the Undo and Redo 
commands.
Undo
Redo
Cut
Copy
Paste
Paste Shared
Delete
Select All
Include Control
Align
Size
Bring to Front
Send to Back



Mode Menu

Use the commands on the Mode menu to change the operating mode.
Select
Link
Create Movement Button
Create Display Media
Create Behavior Button
Create Player Button
Create Text Overlay
Create List Button
Create Launch Button



Page Menu

The Page menu provides commands for working with pages, and previewing the presentation from a 
specific page.
Add
Modify
Delete
Insert
Preview From



Template Menu

Use the Template menu to work with templates.
Add
Modify
Delete
Include



Media Menu

Use the commands on the Media menu to work with media objects.
Import
View
Delete



Properties Menu

The Properties menu lets you work with properties for the different objects, as well as set your 
Preferences for the Open!Info Manager environment.
Preferences
Presentation
Page
Template
Control
Media
Remove Local



Window Menu

Open!Info Manager allows you to open multiple documents at one time, each in a separate window. 
You can open any combination of document windows: Summary, Diagram, Template, and Page. The 
Window menu gives you commands for manipulating these windows.
Cascade
Tile
Arrange Icons
Close All
Summary
Diagram
Window list



Help Menu

Use the Help menu to find information on a wide variety of topics.
Contents
Topic
Using Help
About



Cascade Command

Choose Cascade to arrange the full-size, open windows so you can see the title bar of each, with a 
cascaded or tiered effect.

See Also:
Window Menu



Tile Command

Choose Tile to resize each open window and arrange them so all windows share the available space 
equally.

See Also:
Window Menu



Arrange Icons Command

Arrange Icons positions all window icons in a row at the bottom of the screen. Window icons are 
created when you minimize a Summary, Diagram, Page, or Template window.

See Also:
Window Menu



Close All Command

Close All closes all open windows.

See Also:
Window Menu



Summary Command

Use the Summary command to open the Summary window, or make it the active window if it is 
already open.

See Also:
Window Menu



Diagram Command

Use the Diagram command to open the presentation's Diagram window, or make it the active window
if it is already open.

See Also:
Window Menu



Window List

A list of open windows appears at the bottom of the Window menu. The windows are identified by the 
window name. Choose one of these names to make it the active window.



Contents Command

Contents displays a list of topics available for on-line Help. Alternatively, you can choose the Help 
button from the toolbar to display the Help Contents.

In the Contents, click the desired topic to see associated information.

See Also:
Help Menu



Topic Command

Topic presents a Help topic that discusses the window that is currently active. For example, if you're 
working in the Template window, select Topic from the Help window to see information about the 
Template window.

See Also:
Help Menu



Using Help Command

Using Help provides instructions for using the Windows on-line Help feature. It tells, for instance, how
to move from topic to topic and how to search for a topic of interest.

See Also:
Help Menu



About Command

About displays copyright and version information for Open!Info Manager.

See Also:
Help Menu



Popup Menus

Popup menus are menus can appear almost anywhere on your screen. They pop up in the position of
the pointer when you press the right mouse button, and offer quick access to menu commands.

Popup menus are object-specific, which means the content of the popup menu varies according to 
the object under the pointer: template, page, control, and so forth. For example, the popup menu that 
appears when you point to a control is different from the popup menu that appears when you point to 
a blank area in the Page window.



Summary Window

The Summary window presents a written summary of the presentation. Use this summary to verify 
that you have created the proper number of pages, and that each page is attached to the right 
template. You can also check the presentation properties and see which media objects are in use.

The Summary window may appear automatically when you start a new presentation or open an 
existing one, depending on the Preferences you set. You can access the Summary window at any 
time with one of the following methods.
o Choose Summary from the Window menu, or press F5 to open the window if it is not already 

open.
o Choose the appropriate entry from the list of open windows in the Window menu, or press F5, or 

click anywhere in the window if the Summary window is already open.
Note: If you keep the Summary window open, Open!Info Manager updates its information frequently, 
which can impact overall performance.

This scrollable window is divided into four sections, each summarizing one type of information. Place 
the pointer over any item in this window to see important information about that object in the status 
bar.

Different actions are available in each section of the Summary window.

See Also:
Presentation Properties Section
Presentation Pages Section
Presentation Templates Section
Presentation Media Objects Section



Presentation Properties Section
The Presentation Properties section lists the presentation name, start page, and size, along with the
total number of pages, templates, and media objects the presentation uses. This section is for 
informational purposes only; no actions are available.

See Also
Presentation Pages Section
Presentation Templates Section
Presentation Media Objects Section
Summary Window



Presentation Pages Section
The Presentation Pages section lists the name of each page in the presentation, and identifies the 
template attached to each. Double-click a page name to open its Page window. Right-click over a 
page name to display a popup menu with the following commands:
o Modify Page opens the Page window for the highlighted page. This is equivalent to double-

clicking the page name.
o Modify Template opens the Template window for the template attached to the highlighted page. 

This command is dimmed if no template is attached to the page.
o Delete Page deletes the page from the presentation. Use this command carefully; you cannot 

restore a page that has been deleted.
o Set Start Page sets the highlighted page as the first page presented for viewing.
o Delete Template is dimmed in the Presentation Pages section.
See Also
Presentation Properties Section
Presentation Templates Section
Presentation Media Objects Section
Summary Window



Presentation Templates Section
The Presentation Templates section lists the name of each template created for the presentation, 
and identifies the total number of pages attached to it. Double-click a template name to open its 
Template window. Right-click the template name to display a popup menu with the following 
commands:
o Modify Template opens the Template window for the highlighted template. This command is 

dimmed if no template is attached to the page. This is equivalent to double-clicking the template 
name.

o Delete Template deletes the template from the presentation. Use this command carefully; you 
cannot Undo a template that has been deleted.

o Modify Page, Delete Page, and Set Start Page are dimmed in the Presentation Templates 
section.

See Also
Presentation Properties Section
Presentation Pages Section
Presentation Media Objects Section
Summary Window



Presentation Media Objects Section
The Presentation Media Objects section lists the name of each media object used anywhere in the 
presentation. Double-click a media object name to view the media in a window. 

If a media object name is dimmed, it is a media file placeholder (the file does not exist at the specified
location). You cannot view media file placeholders.

Click the right mouse button over a media object name to display a popup menu with the following 
commands:
o View Media displays the media object in a window. This is equivalent to double-clicking the 

media object name.
o Media Properties displays the Media Properties dialog box, where you can change the media 

object name, and view its filename and media type.
See Also
Presentation Properties Section
Presentation Pages Section
Presentation Templates Section
Summary Window



Diagram Window

Use the Diagram window to create a graphical illustration of the presentation flow. An icon appears for
each presentation page, showing the beginning of the page name. The start page is colored green for
easy identification. 

Any pages created with commands on the Page menu are arranged in rows at the top of the window. 
If you add pages by double-clicking or with the popup menu commands, the page icons are placed at 
the location where you double-click.

The Diagram window is particularly useful at the beginning of the design phase. You can place pages 
visually, and arrange them to show the intended flow of the presentation.

The icons in the Diagram window take on different characteristics to illustrate certain aspects of the 
page.

A green page icon highlights the start page.

A template has been attached to any page whose icon contains this template 
symbol.

An exit button has been defined for any page whose icon contains this exit 
symbol.

Place the pointer over any page icon in this window to see important information about that page in 
the status bar.

The Diagram window may appear automatically when you start a new presentation or open an 
existing one, depending on the Preferences you set. You can access the Diagram window at any time
with one of the following methods.
o Choose Diagram from the Window menu, or press F6 to open the window if it is not already 

open.
o Choose the appropriate entry from the list of open windows in the Window menu, or press F6, or 

click anywhere in the window if the Diagram window is already open.
Note: If you keep the Diagram window open, Open!Info Manager updates its information frequently, 
which can impact overall performance.

See Also:
Creating New Pages in the Diagram Window
Moving Page Icons in the Diagram Window
Diagram Window Popup Menus
Viewing Movement Links in the Diagram Window
Viewing Sequence Links in the Diagram Window



Creating New Pages in the Diagram Window
You can create new pages for the presentation within the Diagram window. Use one of the following 
techniques.
o Double-click over an empty position in the window to place the page icon at the position of the 

pointer.
o Choose Insert from the Page menu to insert a page icon at the top of the window. 
o Move the pointer to the desired location and choose Insert Page from the popup menu. This 

places the page icon at the position of the pointer.
Depending on your settings in Preferences, the Page Properties dialog box may appear. After you 
accept the properties settings, you are returned to the Diagram window.

See Also:
Moving Page Icons in the Diagram Window
Diagram Window Popup Menus
Viewing Movement Links in the Diagram Window
Viewing Sequence Links in the Diagram Window



Moving Page Icons in the Diagram Window
Page icons can be moved in the Diagram Window to illustrate the order the presentation flow. 
1. Place the pointer over a page icon to be moved. 
2. Hold down the mouse button while you drag the icon to a new location. 

The icon moves to the new location, and remains there until you move it again.
See Also:
Creating New Pages in the Diagram Window
Diagram Window Popup Menus
Viewing Movement Links in the Diagram Window
Viewing Sequence Links in the Diagram Window



Diagram Window Popup Menus
Popup menus appear when you click the right mouse button over a page icon or the empty work 
space. These menus give you quick access to various features.

Right-click over a page icon to access these commands:
o Modify Page opens the Page window for the selected page. This is equivalent to double-clicking 

the page icon.
o Modify Template opens the Template window for the template attached to the selected page. 

This command is dimmed if no template is attached to the page.
o Delete Page deletes the selected page from the presentation. Use this command carefully; you 

cannot restore a page that has been deleted.
o Set Start Page sets the selected page as the first page presented for viewing. This command is 

dimmed if the selected page is already the start page.
o Start Preview begins previewing the presentation, starting with the selected page.

Right-click over empty work space (not over a page icon) to access these commands:
o Insert Page creates a new page icon, which appears at the position of the pointer. Double-

clicking at the location has the same effect. 
Depending on your settings in Preferences, the Page Properties dialog box may appear. After 
setting the properties you are returned to the Diagram window. Double-click the page icon (or use
the popup menu) to quickly access the Page window.

o Preferences displays the Preferences dialog box, where you can choose to show or hide the 
Movement Links or Sequence Links, or change any other setting.

See Also:
Creating New Pages in the Diagram Window
Moving Page Icons in the Diagram Window
Viewing Movement Links in the Diagram Window
Viewing Sequence Links in the Diagram Window



Viewing Movement Links in the Diagram Window
Movement links are blue lines that connect page icons in the Diagram window. One line appears for 
each Movement Button Control whose movement type is Go To Page or Back, or for a List Button 
Control with movement items. Thus, one page may be connected by multiple movement links, 
depending on how these options are defined.

The movement link is drawn between the page containing the Movement Button Control and its 
destination page. Arrows indicate the direction of movement. Double arrows indicate that a viewer can
move back and forth between the two pages.

When you click a movement link line the status bar shows the page names that are connected, and 
indicates whether it is a one-way or two-way link.

Open!Info Manager lets you specify which movement links you want to see through the Preferences 
dialog box, or by pressing the shortcut keys. Toggle the settings with the F2 key, or use the shortcut 
key noted below to choose a specific setting.
o All Pages (ALT+F2) shows the movement links for every page in the presentation. Use this 

setting to verify that the presentation flows appropriately. This setting can be useful for 
rearranging the page icons to accurately illustrate presentation flow, and for identifying any pages
that are not yet linked in the presentation.

o Selected Pages (CTRL+F2) shows the movement links for one page at a time. Click the page 
whose movement links you want to see. Click another page to show its movement links and hide 
all others.

o No Pages (SHIFT+F2) hides all movement links. Use this setting, for example, while arranging the
page icons or while viewing sequence links. Then switch to All Pages to verify the proper flow.

See Also:
Creating New Pages in the Diagram Window
Moving Page Icons in the Diagram Window
Diagram Window Popup Menus
Viewing Sequence Links in the Diagram Window



Viewing Sequence Links in the Diagram Window
Sequence links are red lines that connect page icons in the Diagram window. Each line connects a 
page to the destination selected for automated page sequencing. An arrow indicates the direction of 
movement.

When you click a sequence link line the status bar shows the page names that are connected, and 
indicates whether it is a one-way or two-way link. It also shows the amount of time the from page 
must be idle before the to page is displayed.

Open!Info Manager lets you specify which sequence links you want to see through the Preferences 
dialog box, or by pressing the shortcut keys. Toggle the settings with the F3 key, or use the shortcut 
key noted below to choose a specific setting.
o All Pages (ALT+F3) shows the sequence links for every page in the presentation. Use this setting

to verify that the presentation flows appropriately. This setting can be useful for rearranging the 
page icons to accurately illustrate presentation flow, and for identifying any pages that are not yet 
linked in the presentation.

o Selected Pages (CTRL+F3) shows the sequence links for one page at a time. Click the page icon 
whose sequence links you want to see. Click another page icon to show its sequence links and 
hide all others.

o No Pages (SHIFT+F3) hides all sequence links. Use this setting, for example, while arranging the 
page icons or while viewing movement links. Then switch to All Pages to verify the proper 
automated flow.

See Also:
Creating New Pages in the Diagram Window
Moving Page Icons in the Diagram Window
Diagram Window Popup Menus
Viewing Movement Links in the Diagram Window



Toolbar

The Open!Info Manager toolbar gives you quick access to several commonly used commands. As an 
alternative to choosing a command from a menu or using the shortcut keys, click the appropriate tool 
with the mouse.

Initially the toolbar is visible. You can choose whether the toolbar appears or not in the Preferences 
dialog box. Also in the Preferences dialog box you can choose whether to display toolbar tips: popup 
descriptions that appear beside the pointer when it rests on the same tool for a few seconds.

New Presentation starts a new presentation and displays the 
Presentation Properties dialog box. You are prompted to save any 
changes for the open presentation.

Open Presentation lets you open any presentation in the database.

Save Presentation saves the open presentation.

Preview Presentation begins playing the presentation at the start page.

Cut removes the selected controls from the active page or template, and
places them on the Clipboard.

Copy places a copy of the selected controls on the Clipboard without 
changing the original.

Paste places the controls on the Clipboard into the active page or 
template, at the same size and position as the original.

Undo reverses the previous action. (Some actions cannot be undone.) 
You can Undo up to 10 actions in sequence.

Redo reinstates the previously Undone action. You can redo up to 10 
actions in sequence.

Add Page creates a new page and displays the Page window.

Modify Page lets you choose a page to modify.

Add Template creates a new template and displays the Template 
window.

Modify Template lets you choose a template to modify.

Select Mode activates the Select Mode, where you can select objects 
and move or resize them.

Link Mode activates the Link Mode where you can link Behavior Buttons
or Player Buttons to Display Media Controls.

Create Movement Button activates the mode for creating Movement 
Button Controls.

Create Display Media activates the mode for creating Display Media 
Controls.

Create Behavior Button activates the mode for creating Behavior 
Button Controls.

Create Player Button activates the mode for creating Player Button 
Controls.

Create Text Overlay activates the mode for creating Text Overlay 
Controls.



Create List Button activates the mode for creating List Button Controls.

Create Launch Button activates the mode for creating Launch Button 
Controls.

Status Bar

The status bar, located at the bottom of the screen, provides a description and the shortcut keys for 
the menu, command, or tool under the pointer, or information about the object under the pointer. The 
status bar also displays the position of the pointer using X/Y coordinates in pixels and the active 
Mode.

Click and hold the mouse button over a menu, command, or tool to see a description of that item, and
the keyboard shortcut for selectin it. If you do not want to use the selected item, drag the mouse away
before releasing the button.

Place the pointer over a control in the Page or Template window to see information about that control.
Place the pointer over a page icon in the Diagram window, or over a page, template, or media object 
name in the Summary window to see information about that item.

Initially the status bar is visible. You can choose whether the status bar appears or not in the 
Preferences dialog box.



Selection Dialog Boxes

Various Open!Info Manager commands present dialog boxes that let you choose from a list of items. 
For example, when you open a presentation, you see the Open Presentation dialog box. When you 
want to modify a page, you see the Modify Pages dialog box. 
1. Use the scroll bar, the Text field, the Available Types list, and the search options, to bring the 

desired object name into view.
2. Double-click the object name to select it and close the dialog box. 

Alternatively, you can highlight the object name and then choose OK to select the object and 
close the dialog box.
Some selection dialog boxes allow you to select multiple objects. To select multiple objects, hold 
down the SHIFT or CTRL key while clicking additional names. SHIFT selects all objects between the
two clicked. CTRL selects only the individual objects clicked.

See Also:
Creating a Backup File
Deleting a Page
Deleting a Presentation
Deleting a Template
Including a Control
Including a Template
List Button Movement Item
Modifying a Page
Modifying a Template
Movement Button Properties
Previewing a Presentation
Opening an Existing Presentation
Page Properties
Presentation Properties
Publishing a Presentation
Template Properties



Media Selection Dialog Boxes

A media selection dialog box appears whenever you need to choose media for any purpose, such as 
viewing a media file, assigning media to a control, or deleting media from the database.
1. Use the scroll bar to move different parts of the list into view. 

You can also move directly to a particular section with the Text field, or shorten the list with the 
Available Types list and the search options.

2. Select Show Information if you want to see the media properties for the highlighted entry. 
Deselect this option to hide the media properties.

3. Select Play Immediately if you want a media preview to appear for the highlighted entry. 
Deselect this option to omit the preview.
To improve speed, consider deselecting Play Immediately until you highlight an entry of    
particular interest. Then select Play Immediately to see its preview.
A Play button appears near the preview area if Play Immediately is not selected. This becomes a 
Stop button while playable media is being previewed.

4. Click the Play/Stop button to preview the media or discontinue playback of a playable media.
5. Double-click an object name to select it and close the dialog box. 

Alternatively, you can highlight the object name and then choose OK to select the object and 
close the dialog box.
Some media selection dialog boxes allow you to select multiple objects. To select multiple 
objects, hold down the SHIFT or CTRL key while clicking additional names. SHIFT selects all 
objects between the two clicked. CTRL selects only the individual objects clicked.

See Also:
Creating a Backup File
Behavior Button Properties
Deleting Media from the Database
Display Media Properties
Launch Button Properties
Link Properties for Behavior Button Controls
Linking Behavior Button Controls in Link Mode
List Button Behavior Item
List Button Properties
Movement Button Properties
Page Properties
Player Button Properties
Viewing Media in the Database
Template Properties



Available Types List

The Available Types list box provides a quick way to focus your search on a particular type of object.
For example, if you are assigning media to a Display Media Control, you could choose Images in the 
Available Types list box to filter out all media objects that are not images. This shortens the selection 
list, making it easier to find the image you want.

Not all selection dialog boxes offer multiple object types. If you are opening a presentation, for 
instance, the Available Types selection is preset to Presentation; there are no other choices.

See Also:
Text Field
Searching a Selection List
Selection Dialog Boxes
Media Selection Dialog Boxes



Text Field

You can move directly to a certain section of any selection list by typing into the Text field.

Type the first letters of the section you want to see. The highlight bar automatically moves to the 
section of the list that begins with the typed letters, or the closest entry to those letters. 

You can continue typing to further define the entry. For instance, if you type M, the highlight bar 
moves to the first entry that begins with the letter M. If you type MO, the highlight bar moves to the 
first entry that begins with those letters.

Either select the desired entry, or use the other options in the dialog box to search further.

See Also:
Available Types List
Searching a Selection List
Selection Dialog Boxes
Media Selection Dialog Boxes



Searching a Selection List

The search options help you locate an entry if you know only a portion of its name, even if you aren't 
sure of the spelling. This technique is especially useful for very long selection lists.
1. Type a portion of the name into the Text field, even if the spelling is uncertain.

The text you enter can be from any part of the name. Open!Info Manager searches the entire 
name to find matching or similar text.
Add an asterisk (*), called a wildcard, at the beginning or end if the word might contain more 
letters than you entered.

2. Select a search type.
Exact initiates a narrow search, locating all names containing words that exactly match your 
entry.
Fuzzy initiates a broader search, locating object names containing words that are similar to or the
same as your entry, allowing for some variation in spelling. For instance, you can find the word 
background by entering backgrnd and choosing Fuzzy.

3. Click the Find button to begin the search for all entries that exactly or nearly match your entry.
Open!Info Manager presents a new list containing only those entries containing the appropriate 
text.

4. Perform another search on the new list by typing new text and clicking the Find button.
5. Click the Undo button to undo the search and restore the previous list.

If you have performed multiple searches, Undo restores the previous list. Click Undo multiple 
times to return to the original, complete selection list.

6. Either select the desired entry, or use the other options in the dialog box to search further.
See Also:
Available Type List
Text Field
Selection Dialog Boxes
Media Selection Dialog Boxes



Wildcards

You can include wildcard characters (*) in the Text field when searching in a selection dialog box or a 
media selection dialog box.

Place a wildcard character (*) at the beginning or end of any text you enter. This allows the search to 
find words that contain more characters than you entered. For example, entering tele* would find 
telephone, telephoning, telephones, telemarketing, and so on.

Without the wildcard, the text you enter is matched to whole words only. For instance, if you enter at, 
the search will find at, but not Atty.

See Also:
Searching a Selection List



Importing Media

Before you can actually use media in a presentation, you must import it into the Open!Info Manager 
database. Importing creates a media object in the database.
1. Be sure the media file is located in a directory where it can remain until the presentation is 

published. 
If the file is moved to a different directory later, Open!Info Manager converts its media object to a 
placeholder that must be completed.

2. Select Import from the Media menu, or press F9.
The Import Media dialog box appears, where you can select multiple files at once. 

3. Choose one or more files to be imported, then choose OK.
If the message box appears, indicate whether you want to have Open!Info Manager assign each 
media object a name based on the original filename. If you choose Yes, after importing the 
selected media files, the Import Media dialog box returns.
If you selected No, or you are importing only one file, the Media Properties dialog box appears.

4. Enter an object name in the Media Properties dialog box, if appropriate, and choose OK.
If another media object needs to be named, its Media Properties dialog box appears. Otherwise, 
the Import Media dialog box returns.
The Cancel button in the Media Properties dialog box cancels import of the named media file. It 
also terminates the import process. The media objects already created during this import are kept
in the database. Any media files that were selected, but had not yet been imported when you 
chose Cancel are not imported.

5. Repeat these steps until all desired media files have been imported.
Note: Avoid importing media files with identical filenames, even if they are located in different 
directories. If you try to publish presentations that use different media files with identical 
filenames, publishing will rename the duplicate files.

6. Choose Cancel in the Import Media dialog box when you finish importing media files. 
See Also:
Media Menu



Import Media Dialog Box

The Import Media dialog box appears when you choose Import from the Media menu. In this dialog 
box you can select multiple files at once. 
1. Use the List Files of Type list to choose the type of files you want to import.

Animation Files - FLC, FLI formats
Image Files - BMP, DCX, DIB, EPS, GIF, IMG, JPG, PCX, RLE, TGA, TIF, WMF, and WPG 
formats
Sound Files - MID, RMI, and WAV formats
Text Files - TXT format (less than 64 KB in size)
Video Files - AVI, AVS, MOV, and MPG formats
All Files lists files in all of the above formats.

2. Use the Drive and Directory lists to choose a directory containing files to be imported.
3. Select the file(s) you need.

To select multiple files, hold down the SHIFT or CTRL key while clicking filenames. SHIFT selects all
files between the two clicked. CTRL selects only the individual files clicked.
Note: If you later remove the selected file from this directory, Open!Info Manager converts its 
media object to a placeholder.

4. Choose OK.
Note: Support for EPS, WMF, and WPG formats varies according to whether the file contains raster 
or vector layers, and what options you select when saving in these formats. If the display does not 
meet your needs, try selecting different options or saving the file in a different format.

See Also:
Media Menu



Media Properties

The Media Properties dialog box appears automatically when you import media files. You can display 
it at any time by choosing Media from the Properties menu, or by choosing Media Properties from a 
popup menu, or by pressing CTRL+Q.
1. Enter a new name for the media object in the Name field, if desired.

During import Open!Info Manager presents the filename as a default. You can accept that or enter
a different name.
The full path and filename for the selected media file appears below the Name field. If this is a 
placeholder, the name is dimmed to indicate that the file does not yet exist at this location.

2. View the other properties. You cannot change these values.
Source displays the full path and filename for the media file. The Source is dimmed if the object 
is a placeholder (the file does not exist in the named directory). You must complete media file 
placeholders before the media can be viewed in a presentation.
Type indicates whether the file is an animation, image, sound, text, or video file. Open!Info 
Manager determines the file type automatically, based on the file format and extension.
Size indicates the height and width of the image in pixels. For animation and video files, this also 
displays the number of frames. For sound, this becomes a Time field, and shows the length of 
sound in seconds. For text the size is the number of characters in the file.
File Size shows the number of bytes this file occupies.

3. Choose OK when you finish working in the Media Properties dialog box.
See Also:
Importing Media
Media Menu



Creating Media File Placeholders

If a media file does not yet exist in your file structure, you can still use its name as a placeholder in 
the database. Then when you place the file in the proper directory, the database knows where to find 
it. 
1. Choose Import from the Media menu, or press F9.

The Import Media dialog box appears.
2. Open the directory where you plan to place the media file when it is ready.
3. Enter the filename, including extension, into the File Name field.

This should not match an existing filename. Otherwise you'll be creating a standard media object, 
not a placeholder.

4. Choose OK.
The Media Properties dialog box appears, displaying the filename as the default name for the 
new media.

5. Enter a Name for the new media object.
6. Choose OK to return to the Import Media dialog box.
7. Import other files or placeholders, or choose Cancel.

You have created a media object for a media file that has not been stored in the specified 
directory. You can assign this media object as a background, or to any control as you develop the 
presentation. 
When you assign a placeholder, its name appears dimmed in the associated Properties dialog 
box, and in the Summary window. When you preview the presentation, any control whose media 
is a placeholder appears as a box that has diagonal lines.

8. Complete the placeholder so the media can be displayed in your presentations.
Note: After you move the media file into the proper directory, you must restart Open!Info Manager
before it can recognize the new file.

In addition to creating placeholders intentionally, as described above, you can create them 
unintentionally. This happens whenever you delete an imported media file from its directory or move it
to a different directory. See Moved Media Files for information on completing these placeholders.

See Also:
Setting Preferences



Completing Media File Placeholders

Media file placeholders allow you to continue authoring a presentation while the media is being 
developed. Before you can view the media in the presentation, however, you must complete the 
placeholder.
1. View the media list in the Summary window to locate any media file placeholders used in the 

presentation.
Placeholder names are dimmed in the Summary window.

2. Place the pointer over a placeholder name and record    the directory path and filename shown in 
the status bar.
You can also find the directory path and filename in the Media Properties dialog box.

3. Place the completed media file into the proper directory, and give it the appropriate filename.
The file must be given the same filename and be placed into the directory used to create the 
placeholder. If you use a different filename or directory, Open!Info Manager cannot find the file.
Note: If the directory path includes a parenthetical code, such as (VideoPath) or (ImagePath), 
Open!Info Manager will look for the file in multiple paths, and the finished file can be placed in any
of those paths.

4. Exit Open!Info Manager by choosing Exit from the File menu.
5. Restart Open!Info Manager by double-clicking its icon in the Program Manager.

Open!Info Manager recognizes new files only during startup.
See Also:
Creating Media File Placeholders



Multiple Paths and Media File Placeholders

During installation, Open!Info Manager creates an OIM.INI file that contains important program 
information. Part of this information includes a list of directory paths where Open!Info Manager 
expects to find the media files you will import. There are separate entries for different types of media.

When you import a media file or a placeholder from one of these paths, Open!Info Manager 
remembers only the path type from the OIM.INI file (ImagePath, TextPath, and so on). When you view
the Media Properties dialog box, Open!Info Manager checks the OIM.INI file and displays the 
associated directory path.

Sometimes, however, the OIM.INI file contains multiple directory paths for the same path type. This 
happens automatically if you choose not to download the sample presentation during installation. 
Also, you can manually edit the OIM.INI file and enter additional paths.

For example, you might store most media files in two standard locations: the Open!Info Manager 
directories and a network directory. In this case, you might edit the OIM.INI file to add the network 
directory:

ImagePath=c:\oim\media\image;f:\graphics
When you create a media file placeholder from one of the paths listed in the OIM.INI file, Open!Info 
Manager stores only the path type (such as, ImagePath, TextPath). It does not store the actual 
directory path (F:\GRAPHICS) that you specified during the import process. 

When you view the properties for that media file placeholder (either in the Media Properties dialog 
box or the status bar), Open!Info Manager looks for the proper path in the OIM.INI file. Since there 
are multiple options, Open!Info Manager simply gives you the path type. For example:

(ImagePath)\DOLPHIN.BMP
You can place the completed media file into any of the paths listed for that path type in the OIM.INI 
file, regardless of which path you used to create the placeholder. In this example, Open!Info Manager 
could locate the DOLPHIN.BMP file in either of the following directories:

c:\oim\media\image\DOLPHIN.BMP
f:\graphics\DOLPHIN.BMP



Moved Media Files

Sometimes media file placeholders are created unintentionally when you move a media file from the 
directory where it was imported. Generally, the best way to complete this kind of placeholder is to 
move that media file back to its original location.

If there is some reason why the file cannot be returned to the original location, you must import the 
media file again, and assign the new media object wherever the original media object was previously 
assigned.
1. Import the media file again from its new location.
2. Assign the newly created media object to the appropriate controls.

When you're done, the original media object should no longer be assigned to any pages, 
templates, or controls. 

3. Delete the original media object (placeholder) from the database.



Setting Preferences

As you become familiar with Open!Info Manager, you will acquire your own authoring preferences. 
The Preferences dialog box provides options for controlling the appearance of your workspace and 
how certain features behave.
1. Choose Preferences from the Properties menu, or press F3.

The Preferences dialog box appears, showing each of the options you can choose.
2. Choose settings based on how you prefer to work in Open!Info Manager.
3. Choose OK to close the dialog box and activate your selections.
See Also:
Show Toolbar
Show Toolbar Tips
Show Status Bar
Opens Summary
Opens Diagram
Sequence Links
Movement Links
Show Template/Page Properties Automatically
Show Control Properties Automatically
Show Assigned Image in Controls
Marquee Must Surround Controls
Snap to Grid
Grid X
Grid Y
Selection List - Show Icons
Selection List - Search
Add Parentheses to Imported Media Name
Backup Creates Media List File



Show Toolbar

Initially Show Toolbar is selected, so that the toolbar appears at the top of the window. The toolbar 
contains buttons you can click to quickly access common Open!Info Manager commands.

Deselect this option to hide the toolbar and provide more workspace in the Open!Info Manager 
window.

See Also:

Setting Preferences



Show Toolbar Tips

Initially Show Toolbar Tips is selected, so that popup descriptions appear when you rest the pointer 
over a tool. The tip appears only while the pointer rests over the tool.

Deselect this option to hide the toolbar tips if you don't need them.

See Also:

Setting Preferences



Show Status Bar

Initially Show Status Bar is selected, so that the status bar appears at the bottom of the window. The 
status bar displays information about the position of the pointer, the selected control, or the menu 
command or tool the pointer is resting over.

Deselect this option to hide the status bar and provide more workspace in the Open!Info Manager 
window.

See Also:

Setting Preferences



Opens Summary

Initially Opens Summary is selected. This causes Open!Info Manager to automatically open the 
Summary window whenever you create or open a presentation. While it is open, Open!Info Manager 
automatically updates the Summary window with any relevant changes to the presentation, which 
could impact overall performance.

Deselect this option to create or open presentations without opening the Summary window.

See Also:

Setting Preferences



Opens Diagram

Initially Opens Diagram is selected. This causes Open!Info Manager to automatically open the 
Diagram window whenever you create or open a presentation. While it is open, Open!Info Manager 
automatically updates    the Diagram window with any relevant changes to the presentation, which 
could impact overall performance.

Deselect this option to create or open presentations without opening the Diagram window.

See Also:

Setting Preferences



Sequence Links

The Diagram window illustrates all the pages in the presentation. Optionally, you can have it display 
arrows showing the way automated page sequencing moves through the presentation.

All Pages shows the sequence link arrows for all pages in the presentation. This setting can help you
verify that the presentation flow has been properly defined.

Selected Page shows the sequence link arrows for the selected page only. This setting can help you 
verify that page sequencing has been defined properly for individual pages.

No Pages removes all sequence link lines. Use this setting to eliminate clutter as you verify that the 
pages have all been defined.

If both movement links and sequence links are displayed, the movement link arrow will hide a 
sequence link arrow if both go to the same page.

See Also:
Page Properties
Template Properties
Setting Preferences



Movement Links

The Diagram window illustrates all the pages in the presentation. Optionally, you can have it display 
arrows showing the way a viewer can move among the pages with Movement Button Controls.

All Pages shows the movement link arrows for all pages in the presentation. This setting can help 
you verify that the presentation flow has been properly defined.

Selected Page shows the movement link arrows for the selected page only. This setting can help you
verify that individual Movement Button Controls have been set up properly.

No Pages removes all movement link arrows. Use this setting to eliminate clutter as you verify that 
the pages have all been defined.

If both movement links and sequence links are displayed, the movement link arrow will hide a 
sequence link arrow if both go to the same page.

See Also:
Page Properties
Template Properties
Setting Preferences



Show Template/Page Properties Automatically

Each template and page you create has certain properties. Template properties include a name, a 
transition, a background, and an automated page sequence. Page properties include a name, an 
attached template, a transition, a background, and an automated page sequence.

The Properties dialog boxes are used to set the properties for the active page or template. 

Initially Show Template/Page Properties Automatically is selected, so that any time you create or open
a template or page, its Properties dialog box appears first.

Deselect this option if you want to display the Template Properties or Page Properties dialog box only 
when requested.

See Also:
Setting Preferences



Show Control Properties Automatically

Each control you create has certain properties. For instance, all control types contain name, size, and
position properties. Button controls also have primary and selected image properties. A separate 
Properties dialog box is used to set the properties for the each control type. 

Initially Show Control Properties Automatically is selected, so that any time you create a control, its 
Properties dialog box appears first.

Deselect this option if you want to display the control Properties dialog box only when requested.

See Also:
Movement Button Properties
Display Media Properties
Behavior Button Properties
Player Button Properties
Text Overlay Properties
List Button Properties
Launch Button Properties
Setting Preferences



Show Assigned Image in Controls

Assigned image refers to a still, graphic image assigned directly to a control. For example, the 
primary button image is an assigned image. If you assign a graphic image to a Display Media Control,
that is an assigned image. Entered text is the assigned image for a Text Overlay Control. 

The term assigned image does not refer to animation, sound, text, or video media assigned to a 
control.

Initially, Show Assigned Image in Controls is selected, so that the Page and Template windows 
display the image as soon as you assign it to a control.

Deselect this option to hide the assigned images in the Page and Template windows, and display 
colored fill in the controls. The colored fill draws faster than most images.

See Also:

Setting Preferences



Marquee Must Surround Controls to Select Them

The marquee is a box you drag out to select multiple controls for some action. Open!Info Manager 
lets you determine how selections are made with the marquee.

Initially, Marquee Must Surround Controls is not selected so that the marquee automatically selects 
any control it touches.

Select this option to have the marquee select only those controls that are completely surrounded.

See Also:

Setting Preferences



Snap to Grid

As you work in Open!Info Manager, you'll be creating page icons in the Diagram window, and control 
boxes in the Page and Template windows. Your Snap to Grid setting determines how these elements 
can be moved within their windows.

Initially, Snap to Grid is selected so that when you move a page icon or control box, it automatically 
moves to a grid line. Grid lines are spaced at 4-pixel increments by default. 

Deselect this option to allow page icons and control boxes to move freely in the window.

See Also:
Grid X
Grid Y
Setting Preferences



Grid X

Initially, Open!Info Manager sets vertical grid lines every four pixels. Enter a number to change the 
frequency of the vertical grid lines. If Snap to Grid is selected, all page icons and control boxes align 
to one of these grid lines.

See Also:
Snap to Grid
Grid Y
Setting Preferences



Grid Y

Initially, Open!Info Manager sets horizontal grid lines every four pixels. Enter a number to change the 
frequency of the horizontal grid lines. If Snap to Grid is selected, all page icons and control boxes 
align to one of these grid lines.

See Also:
Snap to Grid
Grid X
Setting Preferences



Selection List - Show Icons

Whenever you have to choose an object (template, page, media element, and so on) from a list, 
Open!Info Manager displays a selection dialog box or a media selection dialog box with a list of object
names.

Initially, Show Icons is selected so that the objects in these lists are accompanied by an icon. The icon
helps you visually distinguish between object types.

Deselect this option to hide the icons and show more entries in the list box at one time.

The following icons appear in various selection lists.

Sound icon

Animation icon

AVI video icon

AVS video icon

Bitmap image icon

Movement Button Control icon

Display Media Control icon

Behavior Button Control icon

Player Button Control icon

Text Overlay Control icon

List Button Control icon

Launch Button Control icon

MIDI sound icon

MPEG video icon

Page icon

Playable media icon

Presentation icon

QuickTime Movie video icon

Template icon

Text media icon

WAV sound icon



See Also:

Setting Preferences



Selection List - Search 

Selection and media selection dialog boxes allow you to enter one or more words and search through
the list for entries containing those words. This setting lets you choose whether Fuzzy or Exact is 
selected by default in these dialog boxes.

Initially, Fuzzy is selected so that each time you open a selection or media selection dialog box the 
Fuzzy option is selected by default. When Fuzzy is active, a search finds entries containing words 
that are similar to the words you entered, as well as exact matches. This enables Open!Info Manager 
to find an entry even if the spelling is a bit different than your entry.

Select Exact if you want the default to be Exact in the selection or media selection dialog boxes. 
When the Exact option is used, searches find only those entries containing the exact words you 
entered.

See Also:
Wildcards
Setting Preferences



Add Parentheses to Imported Media Name

When you import media files to create media objects in the Open!Info Manager database, the 
filename is displayed as a default object name. You can include this filename as part (or all) of the 
object name, or replace it completely.

Initially, Add Parentheses is deselected, so that the default object name contains only the filename.

Select this option if you want the filename enclosed in parentheses by default. The parentheses can 
be useful for distinguishing the filename if you use it as part of the object name.

See Also:
Media Properties
Properties Menu



Backup Creates Media List File

Open!Info Manager backup files store data from the database only. The actual media files, which 
reside separately on your hard disk or network, are not stored in the backup file. 

Initially, Backup Creates Media List File is selected so that Open!Info Manager automatically creates 
a separate, media list file whenever you create a backup file. This media list file identifies all the 
media files linked to the backup file, giving the path and filename. The media list file has the same 
name and location as the backup file, with .TXT as the extension. This file is very useful if you plan to 
move the presentation and its media files to a new machine, or want to back up those media files as 
well.

Deselect this option if the backup files are being used for local backup, and you do not plan to copy 
the media files.

See Also:
Creating a Backup File
Setting Preferences



Presentation Properties

Each presentation has certain characteristics, called presentation properties, that affect the overall 
presentation rather than the individual pages and templates. The Presentation Properties dialog box 
appears automatically whenever you create a new presentation, or open an existing presentation. You
can also open this dialog box at any time by choosing Presentation from the Properties menu (or 
pressing CTRL+R).

The properties you set (other than name and start page) are stored in the OIM.INI file. These settings 
are used for all new presentations until you change them.

Name - You can accept the default name Open!Info Manager supplies, or enter a different name. 
It must not duplicate the name of any other presentation in the database.
Width, Height - The initial default width and height are 640 and 480, the base SVGA resolution. 
Set these values according to the size and resolution of the monitor where the presentation will 
be viewed. To prevent controls from appearing outside the page or template boundaries, the page
width and height cannot be changed if you modify the presentation properties later.
Start Page - Click this button to display a dialog box where you can choose the first page 
presented to viewers.
This option is unavailable until you create at least one page. By default, Open!Info Manager uses 
the first page you create as the start page.
Show Title Bar - Select this check box to show the presentation name as a title above the 
presentation during viewing. Deselect this check box to omit the title bar.
If the resolution of the screen is the same as the presentation width and height, the title bar is 
omitted. This allows the viewer to see the entire presentation page.
Allow Text Search for Text Media - Select this check box to let viewers search through text that 
appears in Display Media Controls. Deselect the check box to disallow text searches.
Pages without Backgrounds are Transparent - Select this check box to allow the background 
from the previous page show through when the viewer opens a page that has no background 
image assigned. Deselect this check box to display a solid-color background (from the Windows 
Control Panel) for pages that have no background image assigned.
Align - Choose the default alignment for Text Overlay Controls. You can override this default for 
individual controls. Left starts all text at the left side of the Text Overlay Control box. Center 
centers all text within the control box. Right ends all text at the right side of the control box. 
Justify spaces out the words so the text fills the control box from left to right. (If there is only one 
word, Justify works like Left.)
Border - Select this check box to draw a border around Text Overlay Controls by default. 
Deselect this option to omit the border by default. You can override this default for individual 
controls. The border is a thin line that surrounds the area allocated to the Text Overlay Control.
Shadow - Select this check box to draw shadowed text by default when you create a Text 
Overlay Control. Deselect this option to omit the shadowing effect by default. You can override 
this default for individual controls.
Font - Choose this button to display the Select a Font dialog box, where you can set the default 
font, size, and style for Text Overlay Controls. You can override these defaults for individual 
controls.
Colors - Choose this button to select the default color settings for Text Overlay Controls.
OK -Choose this button to accept the settings and close the dialog box.
Cancel - Choose this button to cancel all changes and close the dialog box. If you choose Cancel
after starting a new presentation, the presentation is canceled as well.

See Also:
Properties Menu



Adding a Page

Open!Info Manager lets you add a new page to the open presentation at any time.
1. Choose Add from the Page menu, click the Add Page tool on the toolbar, or press F7.

The Page Properties dialog box may appear, depending on your Preferences.
2. Enter the properties for this page.
3. Choose OK in the Page Properties dialog box to accept the new settings.

If there is another page in the presentation with the same name, you will be asked whether you 
want to accept the duplicate name or rename the page. If you choose to rename, the Page 
Properties dialog box returns. Choose OK after entering a new name.
The Page window opens, showing the controls and properties of the attached template (if there is
one). 

4. Make local assignments to the global controls created on the template, or create controls that are 
unique to the page.

5. Save the presentation.
Note: You cannot Undo the new page or any previous actions.

See Also:
Inserting a Page



Inserting a Page

Open!Info Manager lets you insert a new page icon into the Diagram window at any time.
1. Insert a new page with one of the following techniques:

o Place the pointer where the page icon should appear in the Diagram window, and double-
click over an open space.

o Place the pointer where the page icon should appear in the Diagram window, then 
choose Insert Page from the popup menu.

o Choose Insert from the Page menu. Open!Info Manager opens the Diagram window (if it 
is not already open) and draws a new page icon in the upper left corner.

Depending on the Preferences you set, the Page Properties dialog box may appear for you to 
enter a name and set other properties. Set the desired properties and choose OK.

2. Move the page icon to its proper place in the presentation flow, if desired.
3. Double-click the page icon, or place the pointer over it and choose Modify Page from the popup 

menu to open its Page window.
Note: You cannot Undo an inserted page or any previous actions.



Page Properties

Page properties are attributes that apply to the page as a whole. Depending on your settings in 
Preferences, the Page Properties dialog box may appear each time you open the Page window. 
Additionally, you can access this dialog box at any time:
o Double-click over the page background (not over a control).
o Right-click over the page background, then choose Page Properties from the popup menu.
o Choose Page from the Properties menu.
o Press CTRL+G.
Set the properties that are appropriate for the page.

Name - You can accept the default name Open!Info Manager supplies, or enter a different name. 
If it duplicates another page name in the presentation, you will be given an opportunity to change 
the name or accept the duplication.
Template - You can attach a template to provide a foundation for the page. Click this button to 
display a dialog box for selecting the template to be attached. Use No Template if you do not 
want the page to reference any template.
The Template button is dimmed if no templates have been created for the presentation.
Transition - The transition is a visual effect when a viewer opens the page. Click this button to 
display the Transitions dialog box where you can select a transition effect for the page.
From Template - Select this check box only if you want to revert to the transition set in the 
attached template. If no template is attached, this check box shows No Transition, and you can 
select it to remove the assigned transition.
You can alternate between the transition selected for the page and the one set in the template (or 
No Transition) as long as the Page Properties dialog box remains open. If you close it with the 
From Template check box selected, the page setting is lost.
Background - Click the Background button to display a dialog box where you can select an 
image to appear as the background for this page. 
If a background was assigned to the attached template, its name appears beside the From 
Template check box. This option is automatically selected and cannot be deselected until you 
assign a background for the page.
If no template is attached, the title From Template does not appear, but the check box is still 
selected to indicate that no background is assigned.
From Template - Select this check box only if you want to revert to the background set in the 
attached template. If no template is attached, this check box shows No Background, and you 
can select it to remove the assigned background image.
You can alternate between the background selected for the page and the one set in the template 
(or No Background) as long as the Page Properties dialog box remains open. If you close it with 
the From Template check box selected, the page setting is lost.
Next Page - Click this button to set up an automatic page change after a specified time period. A 
dialog box lets you choose the page that will be displayed if the viewer does not select an action 
within a given number of seconds.
Seconds Idle - Enter a number of seconds. After the page draws completely, if the viewer does 
not make any selections within this amount of time, Open!Info Manager automatically presents 
the Next Page.
From Template - If a page sequence was set up for the attached template, its Next Page and 
Seconds Idle settings appear beside the From Template check box. This option is automatically 
selected and cannot be deselected until you assign page sequence settings    for the page. If no 
template is attached, the title From Template does not appear, but the check box is still selected 
to indicate that no Next Page has been assigned.



You can alternate between the page sequence selected for the page and the one set in the 
template (or no page sequence ) as long as the Page Properties dialog box remains open. If you 
close it with From Template selected, the page setting is lost.
OK - Choose this button to accept the settings and close the dialog box.
Cancel - Choose this button to cancel all changes and close the dialog box. If you choose Cancel
after starting a new page, the page is canceled as well.



Modifying a Page

After you've created a page, you may need to open it again to review it, to complete it, or to make 
changes and enhancements.
1. Open the Page window in one of the following ways:

o Choose Modify from the Page menu, then select a page from the dialog box that 
appears.

o Press SHIFT+F7, then select the appropriate page from the dialog box.
o Double-click the page icon in the Diagram window, or place the pointer over a page icon 

and choose Modify Page from the popup menu.
o Double-click the page in the Summary window, or select the page and choose Modify 

Page from the popup menu.
2. Make the desired changes.

You can create or change page controls, delete page controls, make local assignments to global 
controls, or change the page properties.

3. Save the presentation after making the changes.



Deleting a Page

Pages can be deleted from the open presentation if they are no longer needed. You can delete one or
more pages by selecting them from a list, or delete individual pages with popup menu commands.

Note: Deleting a page clears the Undo list. You cannot Undo the deleted page, or any actions taken 
before the page was deleted.

Selecting from a List
1. Choose Delete from the Page menu, or press ALT+F7.
2. Select one or more pages from the dialog box, then choose OK.
3. Choose Yes to confirm. 

Open!Info Manager deletes the selected pages from the presentation.

Popup Menu
1. Open the Diagram window or Summary window.
2. Select the page to be deleted.
3. Choose Delete Page from the popup menu.
4. Choose Yes. to confirm.

Open!Info Manager deletes the selected page from the presentation.



Setting the Start Page

The start page is the first page presented to the viewer. Initially Open!Info Manager assigns the first 
page you create as the start page. However, you do not have to create the start page first. 

Set a different start page with one of the following methods.
o Use the Start Page button in the Presentation Properties dialog box.
o Select the appropriate page in the Summary window, then choose Set Start Page from the 

popup menu. Notice that the Presentation Properties section of the Summary window reflects 
your change immediately.

o Select the appropriate page icon in the Diagram window, then choose Set Start Page from the 
popup menu. Notice that the page icon turns green.



Adding a Template

A presentation can have as many templates as it needs. Use the following procedure to add a new 
template.

Note: You cannot Undo a new template, nor can you Undo any previous actions.
1. Choose Add from the Template menu, or press F8.

The Template Properties dialog box may appear, depending on your settings in Preferences.
2. Set the desired properties.
3. Choose OK to accept the properties and open the Template window. 
4. Create controls for the template and set their properties.

After the template is complete you can attach it to all pages that use the same layout.
See Also:
Including a Template
Template Menu



Including a Template

Since different presentations can have pages with similar layouts, Open!Info Manager lets you copy a
template from another presentation. The copy becomes a part of the presentation that is currently 
open. It starts with the characteristics of the original, but you can modify the copy to customize it for 
the current presentation. Your changes do not affect the original template, just the copy.

Note: You cannot Undo the copied template, nor can you Undo any previous actions.
1. Choose Include from the Template menu.
2. Select a presentation from the dialog box that appears, and choose OK.

Another dialog box appears, listing all templates in the selected presentation.
3. Select the template to be copied, and choose OK.

Open!Info Manager copies the template and all its controls into the current presentation as a new 
template. If necessary, Open!Info Manager assigns a new, unique template name. The Template 
window opens.

4. Customize the template for the current presentation, changing its template properties and 
controls as needed.
Open!Info Manager clears any settings that are not meaningful in the current presentation. For 
instance, a Movement Button Control might have a destination page that does not exist in this 
presentation. Be sure to modify the template properties and control properties appropriately.



Template Properties

Template properties are attributes that apply to the template as a whole. Depending on your 
Preferences, the Template Properties dialog box may appear each time you create a template or 
open the Template window. You can also display the Template Properties dialog box at any time with 
one of the following techniques.
o Double-click over the template background (not over a control).
o Right-click over the template background, then choose Template Properties from the popup 

menu.
o Choose Template from the Properties menu.
o Press CTRL+F.
Set the properties appropriate for this template and all the associated pages. 

Name - You can accept the default name Open!Info Manager supplies, or enter a different name. 
If it duplicates another template name in the presentation, you will be given an opportunity to 
change the name or accept the duplication.
Transition - The transition is a visual effect when a viewer opens the associated page. Click this 
button to display the Transitions dialog box, where you can set a transition for this template. You 
can override this transition for individual pages.
Background - Click the Background button to display a dialog box where you can select an 
image to appear as the background for each page that references this template. You can override
this background for individual pages.
Next Page - Click this button to set up an automatic page change after a specified time period. A 
dialog box lets you choose the page that will be displayed if the viewer does not select an action 
within a given number of seconds. You can override the Next Page for individual pages. 
Seconds Idle - Enter a number of seconds. After the page draws completely, if the viewer does 
not make any selections within this amount of time, Open!Info Manager automatically presents 
the Next Page. This field is dimmed if no Next Page has been set.
OK - Choose this button to accept the settings and close the dialog box. Open!Info Manager 
automatically updates all associated pages as soon as you close the Templates Properties dialog 
box.
Cancel - Choose this button to cancel all changes and close the dialog box. If you choose Cancel
after starting a new template, the template is canceled as well.



Modifying a Template

Any time you modify a template, Open!Info Manager immediately updates all the associated pages. If 
any attached pages are open, you can see the changes in those windows, as well.
1. Open the Template window in one of the following ways:

o Choose Modify from the Template menu, then select the appropriate template from the 
dialog box that appears.

o Press SHIFT+F8, then select the appropriate template from the dialog box.
o Place the pointer over a page icon in the Diagram window, and choose Modify Template

from the popup menu.
o Double-click the template name in the Summary window, or select the template and 

choose Modify Template from the popup menu.
o Select a page with an attached template in the Summary window, and choose Modify 

Template from the popup menu.
o Choose Modify Template from the popup menu in any Page window.

2. Make the desired changes.
You can create, change, or delete global controls, or set the template properties.

3. Save the presentation after making the changes.



Display Media Controls

A Display Media Control defines an area for displaying media, which represents the content of a 
page. For example, if a page is to present a video illustrating your product and text describing it, you 
would create two Display Media Controls: one to display video and one to display text.

Display Media Controls can be created in the template or the page. Commonly, if the control is 
created in the template, the media is assigned locally to the individual pages.
1. Activate the template or page where you want to create the control.
2. Activate the Create Display Media Mode.
3. Draw a control box.

The box is filled with diagonal blue lines, indicating that no media has been assigned to the 
control.

4. Set the control properties.
The Display Media Control becomes solid blue if media was assigned. Otherwise, it shows 
diagonal blue lines. (The media image appears instead, if one was assigned and you chose to 
display assigned images in the Preferences dialog box.)



Display Media Properties

The Display Media Properties dialog box lets you assign a name and specific media object to the 
control, as well as set a precise size and position. The Properties dialog box may appear 
automatically after you draw the control box, depending on the Preferences you set. You can also 
display the dialog box at any time.
o Double-click the control.
o Select the control and choose Control from the Properties menu.
o Place the pointer over the control and choose Control Properties from the popup menu.
Set the properties for the control. (The name, size, and position set in a global control cannot be 
overridden for individual pages. If you want to change one of these settings, it must be changed in the
template.)

Name - Make the name as descriptive as possible so this control is easy to identify.
X - The distance from the left side of the page to the left side of the control box, in pixels.
Y - The distance from the top of the page to the top of the control box, in pixels.
Width - The width of the control box, in pixels.
Height - The height of the control box, in pixels.
Media - Displays a dialog box for selecting the media to appear in this Display Media Control.
If you assign media to a Display Media Control globally in the template, that media element 
appears automatically on each page that references the template. You can override the global 
media assignment for individual pages.
Resize Control to Fit - Adjusts the width and height of the control box so it matches the size of 
the selected media. (This button is dimmed if the selected media is sound or text, or if the media 
object is a placeholder).
If you do not select this button, or you change the size later, the media will be scaled to fit the 
control box.
Play Continuously - Select this check box if playable media assigned to this Display Media 
Control should run continuously (loop) while the page is visible. Deselect this option to run the 
playable media only once until restarted from a linked Player Button Control.
This setting affects only playable media: video, animation, and sound, whether it is assigned 
directly in the Display Media Control or is placed there by a Behavior Button Control. If non-
playable media is assigned, this setting has no effect.
OK - The Display Media Control becomes solid blue if media was assigned. Otherwise, it shows 
diagonal blue lines. (The media image may appear instead, depending on your settings in 
Preferences.)
Cancel - Click this button to cancel any changes made, or eliminate the control if it was just 
drawn.



Movement Button Controls

A Movement Button Control defines a button the viewer can click to move from the current page to 
another (destination) page, or to exit the presentation. For example, a page might have three different
Movement Button Controls: one to move forward to the next page, one to move back to the previous 
page, and one to exit the presentation. 

Commonly an Exit button is defined on most templates. Other Movement Button Controls may be 
created on the template, with the destination page assigned locally for individual pages.
1. Activate the template or page where you want to create the control.
2. Activate the Create Movement Button Mode.
3. Draw a control box.

The box is filled with diagonal green lines, indicating that the control has not yet been assigned a 
movement type and destination page.

4. Set the control properties.
The Movement Button Control becomes solid green if movement type and destination page were 
assigned. Otherwise, it shows diagonal green lines. (The primary button image may appear 
instead, depending on your settings in the Preferences dialog box.)



Movement Button Properties

The Movement Button Properties dialog box may appear automatically after you draw the control box,
depending on the Preferences you set. You can also display the dialog box at any time.
o Double-click the control.
o Select the control and choose Control from the Properties menu.
o Place the pointer over the control and choose Control Properties from the popup menu.
Set the properties for the control. (The name, size, position, and button image settings in a global 
control cannot be overridden for individual pages. If you want to change one of these settings, it must 
be changed in the template.)

Name - Make the name as descriptive as possible so this control is easy to identify.
X - The distance from the left side of the page to the left side of the control box, in pixels.
Y - The distance from the top of the page to the top of the control box, in pixels.
Width - The width of the control box, in pixels.
Height - The height of the control box, in pixels.
Primary - Displays a dialog box for selecting an image to appear in this control.
Resize Control to Fit - Adjusts the width and height of the control box so it matches the size of 
the selected primary image. (This button is dimmed if the selected media is a placeholder).
If you do not select this button, or you change the size later, the media will be scaled to fit the 
control box.
Selection Effect - Determines how the primary image changes when a viewer selects the button.

None displays the primary image continuously, without change. 
Flash reverses the colors of the primary image while the viewer holds down the mouse 
button. 
Show Image displays the Selected Image while the viewer holds down the mouse button.

Selected - Displays a dialog box for selecting an image to appear while the viewer holds down 
the mouse button. This button is dimmed unless you choose Show Image as the Selection Effect.
Movement Type - Select what should happen when the viewer clicks this Movement Button 
Control.

Go To Page displays the page selected with the Page button.
Exit closes the presentation.
Back moves back one page.

Page - Displays a dialog box for selecting the page that will appear when a viewer clicks this 
Movement Button Control.
OK - The Movement Button Control becomes solid green if a primary image was assigned. 
Otherwise, it shows diagonal green lines. (The primary image may appear instead, depending on 
your settings in Preferences.)
Cancel - Click this button to cancel any changes made, or eliminate the control if it was just 
drawn.



Behavior Button Controls

Behavior Button Controls define buttons that give the viewer control over the behavior of linked 
Display Media Controls.    For example, a page might use two Display Media Controls, one for 
showing video of the product at work and another for showing a photograph of the product. If you 
want to present two different products on the same page, you could create two Behavior Button 
Controls, one for each product. When the viewer clicks the Product A button, the video and picture of 
Product A appear. When the viewer clicks the Product B button, the video and picture of Product B 
appear. 
1. Activate the template or page where you want to create the control.
2. Activate the Create Behavior Button Mode.
3. Draw a control box.

The box is filled with diagonal cyan lines, indicating that the control has not yet been linked to any
Display Media Controls.

4. Set the control properties.
The Behavior Button Control becomes solid cyan if the button was linked to any Display Media 
Controls. Otherwise, it shows diagonal cyan lines. (The primary button image may appear 
instead, depending on your settings in the Preferences dialog box.)

5. Link the control to Display Media Controls with the Link Mode if the necessary links were not 
established in the Properties dialog box.



Behavior Button Properties

The Behavior Button Properties dialog box may appear automatically after you draw the control box, 
depending on the Preferences you set. You can also display the dialog box at any time.
o Double-click the control.
o Select the control and choose Control from the Properties menu.
o Place the pointer over the control and choose Control Properties from the popup menu.
Set the properties for this control. (The name, size, position, and button image settings in a global 
control cannot be overridden for individual pages. If you want to change one of these values, it must 
be changed in the template.)

Name - Make the name as descriptive as possible so this control is easy to identify.
X - The distance from the left side of the page to the left side of the control box, in pixels.
Y - The distance from the top of the page to the top of the control box, in pixels.
Width - The width of the control box, in pixels.
Height - The height of the control box, in pixels.
Primary - Displays a dialog box for selecting an image to appear in this control.
Resize Control to Fit - Adjusts the width and height so it matches the size of the selected 
primary image. (This button is dimmed if the selected media is a placeholder).
If you do not select this button, or you change the size later, the media will be scaled to fit the new
control size.
Selection Effect - Determines how the primary image changes when a viewer selects the button.

None displays the primary image continuously, without change. 
Flash reverses the colors of the primary image while the viewer holds down the mouse 
button. 
Show Image displays the Selected Image while the viewer holds down the mouse button.

Selected - Displays a dialog box for selecting an image to appear while the viewer holds down 
the mouse button. This button is dimmed unless you choose Show Image as the Selection Effect.
Links - Displays the Link Properties dialog box where you can determine which Display Media 
Controls are affected when a viewer clicks this Behavior Button Control, and how. You can also 
use the Link Mode to link this control to Display Media Controls.
OK - The Behavior Button Control becomes solid cyan if any links were established. Otherwise, it 
shows diagonal cyan lines. (The primary image may appear instead, depending on your settings 
in Preferences.)
Cancel - Click this button to cancel any changes made, or eliminate the control if it was just 
drawn.



Text Overlay Controls

Text Overlay Controls give you a way to present small amounts of text on a page. You might, for 
example, use Text Overlay Controls to create a title, or a list of bulleted items. You can enter one line 
of text for each Text Overlay Control, as well as set the font, alignment, and special effects.
1. Activate the template or page where you want to create the control.
2. Activate the Create Text Overlay Mode.
3. Draw a control box.

The box is filled with diagonal black lines, indicating that text has not yet been entered.
4. Set the control properties.

The Text Overlay Control becomes solid black if text was entered. Otherwise, it shows diagonal 
black lines. (The text may appear instead, depending on your settings in the Preferences dialog 
box.)



Text Overlay Properties

The Text Overlay Properties dialog box lets you enter text for the control and select the look of the 
text, as well as set a precise size and position. The Properties dialog box may appear automatically 
after you draw the control box, depending on the Preferences you set. You can also display the dialog
box at any time with one of the following techniques.
o Double-click the control.
o Select the control and choose Control from the Properties menu.
o Place the pointer over the control and choose Control Properties from the popup menu.
Set the desired properties for this control. (The name, size, and position settings in a global control 
cannot be overridden for individual pages. If you want to change one of these settings, it must be 
changed in the template.)

Name - Make the name as descriptive as possible so this control is easy to identify.
X - The distance from the left side of the window to the left side of the control box, in pixels.
Y - The distance from the top of the window to the top of the control box, in pixels.
Width - The width of the control box, in pixels.
Height - The height of the control box, in pixels.
Text - Type up to 255 characters. If the text does not fit into the Text Overlay Control box, 
consider changing the font size or resizing the control box.
Align - Choose whether the text should be positioned at the Left , Right, or Center of the control 
box. Choose Justify to space out the words to fill the control box from left to right. (If there is only
one word, Justify works like Left.)
Border - Select this check box to draw a thin border line around the control box. Deselect this 
check box to omit the border.
Shadow - Select this check box to draw shadowed text in the control. Deselect this check box to 
omit the shadowing effect.
Font - Displays the Select a Font dialog box, where you can select the font, size, and style for this
Text Overlay Control.
Colors - Displays the Colors dialog box, where you can choose a color for the text.
OK - The Text Overlay Control becomes solid black if text was entered. Otherwise, it shows 
diagonal black lines. (The text may appear instead, depending on your settings in Preferences.)
Cancel - Click this button to cancel any changes made, or eliminate the control if it was just 
drawn.



Launch Button Controls

A Launch Button Control defines a button that launches another Windows application, such as HTI 
Sure!MAPS or Microsoft® Excel. It also can display a specific file, such as a map or spreadsheet. 
When the viewer clicks the Launch Button Control, Open!Info Manager launches the application and 
displays the selected file. After reviewing the information, the viewer closes the application normally to
return to the appropriate page of the presentation.

Note: Do not use a Launch Button Control to start an application that uses an ActionMedia II card to 
display PLV or TrueMotion Classic video. Closing that    application will return to the DOS prompt, not 
the presentation.
1. Activate the template or page where you want to create the control.
2. Activate the Create Launch Button Mode.
3. Draw a control box.

The box is filled with diagonal red lines, indicating that the Command Line has not yet been 
entered.

4. Set the control properties.
The Launch Button Control becomes solid red if the Command Line was entered. Otherwise, it 
shows diagonal red lines. (The primary button image may appear instead, depending on your 
settings in the Preferences dialog box.)



Launch Button Properties

The Launch Button Properties dialog box lets you designate what application to launch and which file 
to display. The Properties dialog box may appear automatically after you draw the control box, 
depending on the Preferences you set. You can also display the dialog box at any time with one of the
following techniques.
o Double-click the control.
o Select the control and choose Control from the Properties menu.
o Place the pointer over the control and choose Control Properties from the popup menu.
Set the properties for this control. (The name, size, position, and button image settings in a global 
control cannot be overridden for individual pages. If you want to change one of these settings, it must 
be changed in the template.)

Name - Make the name as descriptive as possible so this control is easy to identify.
X - The distance from the left side of the page to the left side of the control box, in pixels.
Y - The distance from the top of the page to the top of the control box, in pixels.
Width - The width of the control box, in pixels.
Height - The height of the control box, in pixels.
Primary - Displays a dialog box for selecting an image to appear in this control.
Resize Control to Fit - Adjusts the width and height so it matches the size of the selected 
primary image. (This button is dimmed if the selected media is a placeholder).
If you do not select this button, or you change the size later, the media will be scaled to fit the 
control box. 
Selection Effect - Determines how the primary image changes when a viewer selects the button.

None displays the primary image continuously, without change. 
Flash reverses the colors of the primary image while the viewer holds down the mouse 
button. 
Show Image displays the Selected Image while the viewer holds down the mouse button.

Selected - Displays a dialog box for selecting an image to appear while the viewer holds down 
the mouse button. This button is dimmed unless Show Image is chosen as the Selected Effect.
Command Line - Enter the name (including extension) of the program file for launching the 
application and a document filename in the Command Line field.
If the program files will be in the same directory on every machine where the published 
presentation is viewed, include the full path with the filename. For example: C:\WIN\EXCEL\
EXCEL.EXE.
If the program files might be in different directories on the machines where the published 
presentation is viewed, enter only the filename here. For example: EXCEL.EXE. Be sure that 
each machine where the published presentation is viewed contains the path to this file in its 
search path.
After the program filename, you will generally add a space and the name of a file to be opened 
when the program is run.
Browse - Displays a dialog box where you can browse the directories on your network or local 
hard disk to locate the appropriate program file path and name.
Working Dir - Enter the full path of the directory where files for this application are stored, if it is 
different from the Command Line directory.
OK - The Launch Button Control becomes solid red if a command line was entered. Otherwise, it 
shows diagonal red lines. (The primary image may appear instead, depending on your settings in 
Preferences.)
Cancel - Click this button to cancel any changes made, or eliminate the control if it was just 



drawn.
IMPORTANT: Publishing the presentation does not copy the program files or the document files used 
by a Launch Button Control. You must copy these files separately for distribution. Be sure your license
permits such copying.



Player Button Controls

A Player Button Control defines a button to regulate playable media, such as video, animation, or 
sound, in a linked Display Media Control. You choose what effect this button will have on    the media 
playback.
1. Activate the template or page where you want to create the control.
2. Activate the Create Player Button Mode.
3. Draw a control box.

The box is filled with diagonal yellow lines, indicating that the control has not yet been linked to 
any Display Media Controls.

4. Set the control properties.
The Player Button Control becomes solid yellow if this button was linked to any Display Media 
Controls. Otherwise, it shows diagonal yellow lines. (The primary button image may appear 
instead, depending on your settings in the Preferences dialog box.)

5. Link the control to Display Media Controls with the Link Mode if the necessary links were not 
established in the Properties dialog box.



Player Button Control Properties

The Player Button Properties dialog box may appear automatically after you draw the control box, 
depending on the Preferences you set. You can also display the dialog box at any time with one of the
following techniques.
o Double-click the control.
o Select the control and choose Control from the Properties menu.
o Place the pointer over the control and choose Control Properties from the popup menu.
Set the appropriate properties for this control. (The name, size, position, and button image settings in 
a global control cannot be overridden for individual pages. If you want to change one of these values, 
it must be changed in the template.)

Name - Make the name as descriptive as possible so this control is easy to identify.
X - The distance from the left side of the page to the left side of the control box, in pixels.
Y - The distance from the top of the page to the top of the control box, in pixels.
Width - The width of the control box, in pixels.
Height - The height of the control box, in pixels.
Primary - Displays a dialog box for selecting an image to appear in this control.
Resize Control to Fit - Adjusts the width and height so it matches the size of the selected 
primary image. (This button is dimmed if the selected media is a placeholder).
If you do not select this button, or you change the size later, the media will be scaled to fit the new
control size. 
Selection Effect - Determines how the primary image changes when a viewer selects the button.

None displays the primary image continuously, without change. 
Flash reverses the colors of the primary image while the viewer holds down the mouse 
button. 
Show Image displays the Selected Image while the viewer holds down the mouse button.

Selected - Displays a dialog box for selecting an image to appear while the viewer holds down 
the mouse button. This button is dimmed unless Show Image is chosen as the Selected Effect.
Playback Action - Choose how this Player Button Control will affect the linked Display Media 
Controls.

None indicates that no playback action is selected. If the Playback Action is None, the 
control does not appear when that page is viewed.
Stop stops the media playback, and resets it to play again from the beginning.
Step moves the media forward one frame each time the viewer clicks this button.
Play plays the media from beginning or from the point at which it was paused.
Replay stops the media at its current frame and restarts it at the beginning.
Pause stops the media playback without resetting it to the beginning.

Links - Displays the Link Properties dialog box where you can determine which Display Media 
Controls are affected when a viewer clicks this Player Button Control. You can also link this 
control to Display Media Controls graphically, in the Link Mode.
OK - The Player Button Control becomes solid yellow if any links were established. Otherwise, it 
shows diagonal yellow lines. (The primary image may appear instead, depending on your settings
in Preferences.)
Cancel - Click this button to cancel any changes made, or eliminate the control if it was just 
drawn.



List Button Controls

A List Button Control lets you group one or more options into a single button. When the viewer selects
the List Button Control, a list appears showing each available option. The viewer then chooses an 
option to start its action. List Button Controls can contain any combination of Movement, Launch, and 
Behavior items.
1. Activate the template or page where you want to create the control.
2. Activate the Create List Button Mode.
3. Draw a control box.

The box is filled with diagonal magenta lines, indicating that no list items have been created.
4. Set the control properties.

The List Button Control becomes solid magenta if any list items were defined. Otherwise, it shows
diagonal magenta lines. (The primary button image may appear instead, depending on your 
settings in the Preferences dialog box.)



List Button Properties

The List Button Properties dialog box may appear automatically after you draw the control box, 
depending on the Preferences you set. You can also display the dialog box at any time with one of the
following techniques.
o Double-click the control.
o Select the control and choose Control from the Properties menu.
o Place the pointer over the control and choose Control Properties from the popup menu.
Set the appropriate properties for this control. (The name, size, position, and button image settings in 
a global control cannot be overridden for individual pages. If you want to change one of these values, 
it must be changed in the template.)

Name - Make the name as descriptive as possible so this control is easy to identify.
X - The distance from the left side of the page to the left side of the control box, in pixels.
Y - The distance from the top of the page to the top of the control box, in pixels.
Width - The width of the control box, in pixels.
Height - The height of the control box, in pixels.
Primary - Displays a dialog box for selecting an image to appear in this control.
Resize Control to Fit - Adjusts the width and height so it matches the size of the selected 
primary image. (This button is dimmed if the selected media is a placeholder).
If you do not select this button, or you change the size later, the media will be scaled to fit the new
control size.
Selection Effect - Determines how the primary image changes when a viewer selects the button.

None displays the primary image continuously, without change. 
Flash reverses the colors of the primary image while the viewer holds down the mouse 
button. 
Show Image displays the Selected Image while the viewer holds down the mouse button.

Selected - Displays a dialog box for selecting an image to appear while the viewer holds down 
the mouse button. This button is dimmed unless Show Image is chosen as the Selected Effect.
Items - Displays the List Button Control Items dialog box where you can define the actions for this
List Button Control.
OK - The List Button Control becomes solid magenta if any items were defined. Otherwise, it 
shows diagonal magenta lines. (The primary image may appear instead, depending on your 
settings in Preferences.)
Cancel - Click this button to cancel any changes made, or eliminate the control if it was just 
drawn.



Link Properties for Behavior Button Controls

When you select the Links button in the Behavior Button Properties dialog box, the Link Properties 
dialog box appears. Use this dialog box to select the Display Media Controls whose behavior will be 
altered when a viewer clicks this Behavior Button Control, and to select the media that will appear in 
each.
1. Choose the Links button in the Behavior Button Properties dialog box.

The Link Properties dialog box appears, showing the names of all Display Media Controls on the 
same page or template. Existing links are indicated with an asterisk (*) beside the control name.

2. Select a Display Media Control from the list, then choose the Set Link button to establish a link to
it.
A media selection dialog box appears, listing all media objects in the database.

3. Select the media object to appear in the selected Display Media Control when a viewer clicks this 
Behavior Button Control.
The Link Properties dialog box returns showing an asterisk beside the Display Media Control 
name. The linked media object name appears below the list of Display Media Controls.

4. Link to additional Display Media Controls by repeating steps 2 and 3, as needed.
5. Remove any unwanted links by highlighting the Display Media Control and choosing the Remove

Link button.
6. Choose OK to accept the established links, or choose Cancel to cancel the links.
See Also:
Linking Behavior Button Controls in Link Mode
Removing Links in Link Mode



Linking Behavior Button Controls in Link Mode

Behavior Button Controls can be linked to Display Media Controls graphically with the Link Mode 
outside the Behavior Button Properties dialog box.
1. Select the Behavior Button Control you want to link.
2. Activate the Link Mode.

Notice that a link symbol appears when the pointer is over a Display Media Control. If the pointer 
is outside a Display Media Control area the arrow pointer appears. You cannot establish a link 
unless the link pointer is visible.

3. Place the pointer over a Display Media Control to be linked.
Eligible Display Media Controls are shown with diagonal lines, if assigned images are not shown. 
If a Display Media Control is solid blue, it has already been linked to this Behavior Button Control.

4. Choose the appropriate action from the popup menu.
No Media establishes a link to this Display Media Control. When the viewer selects this Behavior 
Button, the Display Media Control is cleared, and no new media is displayed. The viewer sees 
either the page background or any controls that were layered beneath the cleared Display Media 
Control.
Set Media establishes a link, and displays a media selection dialog box.

5. Select a media object to appear in the Display Media Control when a viewer clicks this Behavior 
Button Control.

6. Link additional Display Media Controls by repeating steps 3-5.
7. Exit the Link Mode by activating either the Select Mode or a Create Mode.
See Also:
Link Properties for Behavior Button Controls
Removing Links in Link Mode



Removing Links in Link Mode

Any link established between a Behavior Button Control or Player Button Control and a Display Media
Control can be removed quickly and easily in the Link Mode. You can remove individual links or 
remove all links at once.
1. Select the appropriate Behavior or Player Button Control.
2. Activate the Link Mode.
3. Remove the desired links with one of the following techniques.

o Place the pointer over a Display Media Control whose link is to be removed, then select 
Remove Link from the popup menu. (Linked Display Media Controls appear with solid 
blue fill if assigned images are not shown.)

o Place the pointer outside any Display Media Control (in the empty workspace), then 
choose Remove All Links from the popup menu.

You can continue working in the Link Mode, or choose a different mode.
See Also:
Linking Behavior Button Controls in Link Mode
Linking Player Button Controls in Link Mode



Link Properties for Player Button Controls

When you select the Links button in the Player Button Properties dialog box, the Link Properties 
dialog box appears. Use this dialog box to select the Display Media Controls that will be affected 
when a viewer clicks this Player Button Control.
1. Choose the Links button in the Player Button Properties dialog box.

The Link Properties dialog box appears, showing the names of all Display Media Controls on the 
same page or template. Existing links are indicated with an asterisk (*) beside the control name.

2. Select a Display Media Control from the list, then choose the Set Link button to establish a link to
it.

3. Select a Display Media Control that has already been linked and choose Remove Link to remove
any unwanted links.

4. Set or remove additional links by repeating steps 2 and 3.
Note: You can play only one AVS video with the same Player Button Control. However, you can 
play multiple animations and sound media. 

5. Choose OK to accept the established links, or choose Cancel to cancel the links.
See Also:
Linking Player Button Controls in Link Mode
Removing Links in Link Mode



Linking Player Button Controls in Link Mode

Player Button Controls can be linked to Display Media Controls graphically with the Link Mode outside
the Player Button Properties dialog box.
1. Select the Player Button Control you want to link.
2. Activate the Link Mode.

Notice that a link symbol appears when the pointer is over a Display Media Control. If the pointer 
is outside a Display Media Control area the arrow pointer appears. You cannot establish a link 
unless the link pointer is visible.

3. Place the pointer over a Display Media Control to be linked.
Eligible Display Media Controls are shown with diagonal lines, if assigned images are not shown. 
If a Display Media Control is solid blue, it has already been linked to this Player Button Control.

4. Choose Set Link from the popup menu:
The Player Button Control becomes solid yellow after a link has been established. (The actual 
may image appear instead, depending on your settings in Preferences.)

5. Link additional Display Media Controls by repeating steps 3 and 4.
6. Exit the Link Mode by activating either the Select Mode or a Create Mode.
See Also:
Link Properties for Player Button Controls
Removing Links in Link Mode



Loading a Backup File

Backup files can be loaded into any Open!Info Manager database. The backup file does not contain 
actual media files. It contains only media objects. If you are loading the backup file on a different 
machine, be sure the media files have been copied to that machine as well.
1. Choose Load Backup from the File menu.
2. Select the appropriate path and filenames from the Load Backup File dialog box, then choose 

OK.
Open!Info Manager begins loading the backup files into the database. Depending on the number 
and size of the files being loaded, this may take a few minutes. A message box indicates 
progress. 
The list box at the bottom reports any errors, warnings, or notes of interest, such as presentations
that have been renamed to avoid duplicate names. All messages are stored in a text file called 
ERRORS.TXT and stored in the OIM directory for later viewing.
If an error occurs, the backup file cannot be loaded. You must cancel the Load. If you selected 
multiple backup files to load, only those that were completely loaded before the error occurred will
be loaded. 

3. Choose the OK button when loading is complete. 
You can now open a presentation that was loaded, or preview and use any media that was 
loaded.
If you cancel the Load in process, the current backup file is not loaded, and any other files you 
selected for loading are also canceled. If any backup files were completely loaded before you 
canceled, their objects remain in the database after you cancel.

See Also:
Creating a Backup File



Creating a Backup File

You can create a backup file for selected presentations, selected media objects, or for the entire 
database.
1. Choose Create Backup from the File menu.
2. Choose the type of information to be backed up from the submenu.

Presentation creates a backup file containing information on the presentations you select.
Media creates a backup file containing selected media objects from the database.
All creates a backup file containing all presentations in the database and all media objects in the 
database.

3. Select one or more presentations or media objects to be included in the backup file, if 
appropriate.
The Backup File Name dialog box appears.

4. Enter a name for the backup file and choose a directory path, or accept the default presented.
It is not necessary to enter an extension. Open!Info Manager automatically provides the 
extension .OIM.

5. Choose OK.
Open!Info Manager displays status information as it creates the backup file. A message box 
indicates when the file is complete.
Depending on the Preferences    you set, Open!Info Manager may also create a media list file to 
help you determine what media files are represented by the media objects in the backup file.

See Also:
Loading a Backup File



Clearing the Database

Use the Clear All option to delete everything from the database, including all media objects.
1. Store the presentations and media objects in a backup file before you clear the database. 

You cannot use the Undo command after clearing the database entirely. The only way to restore 
any objects cleared from the database is to load the appropriate backup file.

2. Choose Clear All from the File menu.
You are asked to verify that you want to remove all objects from the database.

3. Choose Yes.
The database is emptied. You can load a backup file, or begin creating new presentations. 

Remember, this does not delete media files from your hard disk. It merely deletes the media objects 
from the Open!Info Manager database.



Exiting Open!Info Manager

To exit Open!Info Manager, choose Exit from the File menu. Alternatively, you can double-click the 
control menu box in the upper left corner of the window, or press ALT+F4.



Previewing a Presentation

Previewing a presentation allows you to verify that all settings have been implemented properly and 
determine the presentation's effectiveness. Start a preview at any time during the development 
process. All the tools to make corrections and enhancements are right at your fingertips. After you 
make changes, preview it again to see their effect.
1. Open the presentation you want to preview.
2. Select Preview from the File menu, or click the Preview tool on the toolbar, or press F4.

Open!Info Manager begins playing the open presentation, beginning with the page selected as 
the Start Page. 
To begin previewing with the page that is open in the Page window or selected in the Diagram 
window, press SHIFT+F4, or choose Start Preview from the popup menu.
You can also begin a preview with any page in the presentation. Choose Preview From on the 
Page menu, then choose a page from the selection dialog box.

3. Navigate through the presentation by clicking the buttons you built into the pages. 
When you move the mouse pointer onto a button's area, the pointer changes from an arrow to a 
hand. Click the mouse when the hand is visible to perform that button's action.

4. Exit the preview at any time.
If changes are needed, you can quickly access the templates and pages that need further work, 
make your changes, then preview the presentation again.

See Also:
Searching for Text



Creating a Presentation

Once you have designed the presentation and begun gathering media, you are ready to assemble 
these elements by creating a new presentation.
1. Choose New from the File menu, or click the New Presentation tool on the toolbar, or press 

CTRL+N.
Open!Info Manager displays the Presentation Properties dialog box.

2. Set the desired properties for this presentation.
3. Create the needed templates and pages.
4. Review the presentation flow in the Diagram window.
5. Review the information in the Summary window.
6. Preview the presentation. 
7. Save the presentation.



Opening an Existing Presentation

You can open any presentation in the database for preview or modification.
1. Select Open from the File menu, or click the Open Presentation tool on the toolbar, or press 

CTRL+O.
2. Select one of the available presentations from the dialog box that appears.

If the presentation you want has been deleted from the database, you must load its backup file 
before you can open it.

3. Choose OK to open the presentation.
If the currently open presentation has changes that have not been saved, you are given an 
opportunity to save them.
Open!Info Manager opens the selected presentation. The Summary or Diagram window may 
open, depending on the Preferences you set. Preview the presentation, or make any needed 
changes.



Resizing a Control

After you draw a control box you may decide it is not quite the right size. Open!Info Manager lets you 
resize a control box graphically with the resizing handles that appear when you select the control. You
can see the effect as you resize the box vertically, horizontally, or proportionally.
1. Activate the Select Mode.
2. Select the control to be resized.

The resizing handles appear around the box if the control was created on this page or template. If
you have selected a global control in the Page window, no resizing handles appear, only a thick 
black border. You cannot resize a global control in the Page window.

3. Drag one of the resizing handles to the new size.
Side handles let you resize the box horizontally.
Top and bottom handles let you resize the box vertically.
Corner handles let you resize the box proportionally.
The status bar indicates the control size as you drag.
If Snap to Grid is active, the control box always resizes to a grid line.

4. Release the mouse button when the box is at the appropriate size.
You can also set a precise pixel size and position for any control in its Properties dialog box.

See Also:
Movement Button Properties
Display Media Properties
Behavior Button Properties
Player Button Properties
Text Overlay Properties
List Button Properties
Launch Button Properties



Deleting a Control

You can delete a control on the template or page where it was created.
1. Activate the Select Mode.
2. Select one or more controls.
3. Press the DEL key, or choose Delete from the popup menu, or choose Delete from the Edit menu.

The controls are deleted from the template or page. They are also deleted from the database, 
with one exception. A shared control (global control that has been copied to another template with
the Include Control or Paste Shared command) is removed from the current template, but not 
from any other template that is using it. If no other template is using the shared control, it is also 
deleted from the database when the presentation is saved.
You can use the Undo command on the Edit menu if you want to restore the control.

Note: You cannot delete a global control from an individual page. To remove a global control from a 
page, you must delete it from the template, or choose a different template for the page.



Setting Local Properties for Global Controls

Some global controls are not completely defined in the template, or need to be modified for individual 
pages. For example, you might define a global Movement Button Control but assign the destination 
page separately for each page. Perhaps several pages show the corporate logo in the same place, 
but on one page a different graphic should be shown.

You cannot change the name, size, position, or button image settings of a global control in the Page 
window, but you can change any of its type-specific properties.

Note: Global controls that have local properties are not updated with changes made to type-specific 
properties in the template. See Removing Local Properties.
1. Select a global control in the Page window.

The control box becomes a thick black line to indicate that it is selected.
2. Choose Control from the Properties menu, or choose Control Properties from the popup menu.
3. Enter any changes in the Properties dialog box that appears.

Notice that the Name, X, Y, Width, Height, and Button Image fields are dimmed, indicating that 
they cannot be changed. However, you can modify any other property.

4. Choose OK to accept the local properties.
See Also:
Movement Button Properties
Display Media Properties
Behavior Button Properties
Player Button Properties
Text Overlay Properties
List Button Properties
Launch Button Properties



Removing Local Properties

You cannot delete global controls from an individual page. However, you can delete the local 
properties set in the page.
1. Activate the Select Mode.
2. Select a control.

You cannot select multiple global controls while working on a page.
3. Choose Remove Local from the Properties menu, or choose Remove Local Properties from 

the popup menu.



Viewing Media in the Database

You can view media that has been imported into the database at any time. If you plan to view video or
sound media objects, consider setting up the volume controls that came with your sound card so that 
you can control the volume during viewing. Refer to the sound card documentation for details.
1. Choose View from the Media menu.
2. Choose Imported from the submenu.

A media selection dialog box lists all media objects in the database.
3. Select the media object you want to view.
4. Choose OK.

Open!Info Manager displays the selected media in a separate media view window. Use the popup
menu in that window to control the display.

5. Press ALT+F4, or double-click the control box in the upper left corner to close the media view 
window.

See Also:
Viewing Media Outside the Database



Viewing Media Outside the Database

You can view media that has not yet been imported into the Open!Info Manager database, perhaps to
help you decide which media to import.
1. Choose View from the Media menu.
2. Choose Other from the submenu to display the View Other Media dialog box.
3. Use the List Files of Type list to choose a particular type of media to view.
4. Use the Drive and Directories lists to choose a directory path whose files you want to view.
5. Select a media file in the File Name list, or type a name into the File Name field.
6. Choose OK.

Open!Info Manager displays the selected media file in a separate media view window. Use the 
popup menu in that window to control the display.

7. Press ALT+F4, or double-click the control box in the upper left corner to close the media view 
window.

See Also:
Viewing Media in the Database



Deleting Media from the Database

A large number of media objects in the database can mean a long list to search through when you 
assign media. You can shorten this list by deleting some of the media objects that are not currently 
needed.

Deleting a media object does not delete the actual media file from your hard disk. It merely removes 
Open!Info Manager's link to that media file. You can restore the link by importing that media file again,
or by loading a backup file with the media object.

Note: You cannot Undo a deleted media object.
1. Choose Delete from the Media menu.

A dialog box lists all media that is not currently used by any presentation in the database. You 
cannot delete a media object that has been assigned to a presentation. If you assigned a media 
object in the open presentation, then deleted that assignment, the media object cannot be deleted
until the presentation has been saved.

2. Select one or more objects from the list.
3. Choose OK.
4. Choose Yes when asked to confirm the delete request.

The selected media objects are deleted from the database.



Saving a Presentation

Saving a presentation stores each of its objects in the database, making it available for future Open!
Info Manager sessions. Be sure to save the presentation periodically as you work to protect against 
loss in the event of a power failure or other problem.

You can save a presentation in one of three ways.
o Choose Save from the File menu. 
o Click the Save tool on the toolbar. 
o Press CTRL+S. 
Open!Info Manager saves the presentation under the name entered in the Presentation Properties 
dialog box.

Note: You cannot Undo the saved presentation, or any previous actions.

See Also:
Copying a Presentation
Creating a Backup File



Copying a Presentation

Copying a presentation gives you a new version that you can use as the basis of a new presentation, 
or to test changes that you're not sure you'll want to keep. 
1. Open the presentation to be copied.
2. Choose Save As from the File menu.

The Presentation Properties dialog box appears.
3. Enter a new name for the presentation, and choose OK.

Open!Info Manager duplicates the presentation and all its objects, and saves them under the 
name you enter. The copy is opened automatically, allowing you to make changes right away.

An alternative technique is to load the presentation's backup file twice. Open!Info Manager 
automatically assigns a new, unique name to the presentation during loading if there is already 
another presentation with the same name.



Deleting a Presentation

You can keep the database to a minimum by deleting presentations you're not currently working with, 
such as those that are already published, or are temporarily on hold.
1. Create a backup file for the presentation if you want to store it for future use or revision.

Deleted presentations cannot be restored unless they have been saved in a backup file.
2. Choose Delete from the File menu.
3. Select one or more presentations from the dialog box, then choose OK.
4. Choose Yes when asked to confirm that the presentations should be deleted.

Open!Info Manager asks whether you want to also delete the media objects associated with the 
deleted presentation.

5. Choose Yes to delete the media objects, or No to leave them in the database.
The presentations are deleted from the database. If you elected to delete the media objects, they 
are deleted from the database as well. However, Open!Info Manager does not delete any media 
object that is used by another presentation in the database.
If you choose Cancel, the entire delete request is canceled.
Note: You cannot Undo a deleted presentation. To restore a presentation that was previously 
backed up, use the Load Backup command.



Create Modes

Use the Create Modes to create new controls. There is a separate Create Mode for each control type.
To activate a Create Mode choose the appropriate Create Control command from the Mode menu, or
choose the appropriate Create tool from the toolbar, or press the shortcut keys listed below.

For this Create Mode Press
Movement Button Control CTRL+M
Display Media Control CTRL+D
Behavior Button Control CTRL+B
Player Button Control CTRL+P
Text Overlay Control CTRL+T
List Button Control CTRL+I
Launch Button Control CTRL+H



Select Mode

Use the Select Mode to choose one or more controls for the next action. For example, you might 
select a control to resize, or select a control to link, or select two controls to move.

You can activate the Select Mode in several ways:
o Click an existing control while in a Create Mode or the Link Mode. 
o Choose Select from the Mode menu.
o Click the Select tool on the toolbar.
o Press CTRL+E.
Once you have activated the Select Mode, use any of the following methods to select one or more 
controls:
o Select one control by clicking anywhere in its box. If you select a control that can be moved and 

resized Open!Info Manager displays resizing handles.
If you select a global control while working in the Page window, Open!Info Manager draws a dark 
border around the selected control. No handles appear because the control cannot be moved or 
resized.

o Select additional controls by pressing the SHIFT or CTRL key while clicking the control box. If you 
click another control without holding down the SHIFT or CTRL key, the first control is deselected 
and the second is selected.

o Select multiple controls at once by placing the pointer outside one control, then holding down the 
mouse button while dragging out a marquee around all controls to be selected. 

o Select all controls at the same time by choosing Select All from the Edit menu or pressing 
CTRL+A.



Link Mode

The Link Mode is used for graphically linking a Player Button or Behavior Button Control to the 
appropriate Display Media Controls. Activate the Link Mode by choosing Link from the Mode menu, 
or by choosing the Link Mode tool from the toolbar, or by pressing CTRL+L.

See Also:
Linking Behavior Button Controls in Link Mode
Linking Player Button Controls in Link Mode
Removing Links in Link Mode



Control Fills

As you work with controls, Open!Info Manager uses different graphical fills to help you quickly identify 
those controls whose primary property has been set, and those that still need to be set.

If you choose to work with the assigned image displayed, these fills are visible only before you assign 
an image to the control.

Diagonal fill indicates that the control's primary property has not been set.

Solid fill indicates that the control's primary property has been set. If the primary property is set for 
the page, the fill is a darker color than if it was set for the template.

See Also:
Control Colors



Primary Properties

Open!Info Manager changes the graphical fill of a control box to illustrate whether its primary property
has been set, and where. The primary properties for each control type are listed below.

Control Type Primary Property
Movement Button Movement Type and Destination Page (if needed)
Display Media Media Assignment
Behavior Button Link to a Display Media Control
Player Button Link to a Display Media Control
Text Overlay Text
List Button List Item
Launch Button Command Line

See Also:
Control Colors



Layered Controls

You can layer controls in different ways to create special effects in the presentation. The control in 
front is activated whenever the viewer clicks an overlapping area.

For example, you might create a Movement Button Control that fills the entire screen, and place all 
other controls in front of it. The viewer can click other controls to start their action, or click the page 
background (the large Movement Button Control) to move through the presentation.

However, the drawing order (front to back) cannot be altered on the page if the overlapping controls 
were not originally created on the page. Global controls are always drawn at the back. You can set 
their order within the template. Global controls with local properties are always drawn in front of global
controls without local properties. Page controls are always drawn in front of all other controls. You can
set their order in the page.

Use the Send to Back and Bring to Front commands if you need to change the order in which 
overlapping controls are drawn.
1. Select the control whose layer is to be changed.
2. Choose the appropriate command, either from that control's popup menu or from the Edit menu:

Send to Back moves the current control to the back layer.
Bring to Front moves the current control to the front layer.



Exiting a Preview

There are several ways to exit a presentation you are previewing.
o Click the Exit button you created on the page to return to the window from which you started the 

preview.
o Click the right mouse button anywhere in the preview to display a popup menu with the following 

options:
Exit returns to the window from which you started the preview. 
Exit to Page returns to the Page window showing the page where you exited the preview.
Exit to Template returns to the Template window showing the template attached to the page 
where you exited the preview.

o Press ALT+F4.



Open!Info Reader

Open!Info Reader is a royalty-free runtime program that allows viewers to view presentations created 
in Open!Info Manager. Open!Info Reader is provided as part of the Open!Info Manager package. It is 
designed for distribution, and contains no authoring functionality. When you publish a completed 
presentation, Open!Info Reader is automatically published along with it. 

Open!Info Reader can operate from a portable PC, workstation, or a kiosk environment to reach the 
general public. The viewer's system must be set up with all hardware and software required to view 
the presentation. For example, if the presentation plays PLV video, Open!Info Reader must be run on 
a system that contains an ActionMedia II card (or equivalent) with 2 MB of VRAM. If the presentation 
launches another application, that application must be licensed and installed separately.

Viewing a presentation with Open!Info Reader is like previewing a presentation from Open!Info 
Manager. The viewer simply clicks buttons and follows on-screen cues. 

See Also:
Distributing Published Presentations



Drawing a Control Box

Every control represents an area where some media or text will appear, or an area for viewer 
interaction. One part of creating any control, regardless of the type, is drawing a control box to identify
the size and placement of the control. 
1. Choose a Create Mode.

The pointer becomes a crosshair as you move it over the workspace.
2. Place the crosshair at one corner of the control area and press down the left mouse button.
3. Hold down the mouse button while dragging diagonally to create a box of the appropriate size.

Notice that the status bar shows the position (X and Y) of the pointer, as well as the height and 
width of the control box as you draw. These values are displayed in pixels. You can modify the 
position, height, or width later either graphically or in the associated Properties dialog box.

See Also:
Control Fills
Control Colors



Control Colors

After you draw the control box, Open!Info Manager assigns a color to it, based on the type of control 
you're creating. Use the colors to help you distinguish the control types as you work. (The status bar 
also indicates control type when the pointer rests over a control box.)

Control Type Color
Movement Button Green
Display Media Blue
Behavior Button Cyan (bluegreen)
Player Button Yellow
Text Overlay Black
List Button Magenta (pinkish purple)
Launch Button Red

If you have chosen to display the assigned images, these colors appear until the image is assigned.

See Also:
Control Fills



Deleting a Template

If a template becomes obsolete and will not be needed for future presentation development, you can 
delete it from the database.

Note: You cannot Undo a deleted template, or any previous actions.
1. Check the Presentation Templates section in the Summary window to determine whether the 

template is being used by any pages.
If you delete a template that is attached to any page, you may need to modify that page after 
deleting its template.

2. Choose Delete from the Template menu, or press ALT+F8.
You can also delete a template in the Summary window. Select the template name and choose 
Delete Template from the popup menu.

3. Select one or more templates from the dialog box that appears.
4. Choose OK.

After you confirm the request, Open!Info Manager deletes the selected templates from the 
database.
Note: If the deleted template shares any controls with other templates, the shared controls are 
not deleted on the remaining templates.



List Button Control Items

Use the List Button Control Items dialog box to define one or more items for the viewer to choose 
after selecting this List Button in the presentation.
1. Create a List Button Control and open its Properties dialog box.
2. Choose the Items button.

The List Button Control Items dialog box appears.
3. Create one or more Movement items.
4. Create one or more Launch items.
5. Create one or more Behavior items.
6. Select an unwanted item from the list and choose the Delete button to delete it.
7. Choose OK to accept the items and return to the List Button Properties dialog box.



List Button Movement Item

A List Button Movement item lets the viewer move to a new page in the presentation. A movement 
item is equivalent to a Movement Button Control whose movement type is Go To Page.
1. Choose the Add Movement button in the List Button Control Items dialog box.

The dialog box displays the appropriate fields, if they are not already visible.
2. Enter a name for this Movement item in the Name field.

Be sure the name clearly describes the action to be taken; this is the text the viewer will see when
choosing an option from the list.

3. Choose the Page button to display a dialog box listing the names of all pages in the presentation.
4. Select the desired destination page, and choose OK.

The List Button Control Items dialog box returns, showing the selected page name beside the 
Page button.

See Also:
List Button Controls
List Button Behavior Item
List Button Launch Items



List Button Behavior Item

Like a Behavior Button Control, a List Button Behavior item affects the behavior of linked Display 
Media Controls. 
1. Choose Add Behavior in the List Button Control Items dialog box.

The dialog box displays the appropriate fields, if they are not already visible.
2. Enter a name for this Behavior item in the Name field.

Be sure the name clearly describes the action to be taken; this is the text the viewer will see when
choosing an option from the list.

3. Choose the Link button to display the Link Properties dialog box.
This dialog box lists each Display Media Control defined for the same template or page. Existing 
links are indicated with an asterisk (*) before the control name. 

4. Select a Display Media Control from the list, then choose the Set Link button to establish a link to
it. 
A media selection dialog box appears.

5. Select the media object to appear in the linked Display Media Control (step 4) when a viewer 
chooses this Behavior item.
An asterisk appears beside the Display Media Control name, and the selected media object 
appears below the list.

6. Link this Behavior item to additional Display Media Controls by repeating steps 4 and 5.
7. Remove any unneeded links by selecting that Display Media Control in the list and choosing the 

Remove button.
8. Choose OK in the Link Properties dialog box.

The List Button Control Items dialog box returns, showing the number of links established.
See Also:
List Button Controls
List Button Movement Item
List Button Launch Item



List Button Launch Item

Like a Launch Button Control, a List Button Launch item launches another Windows application to 
display information relevant to the presentation.
1. Choose the Add Launch button in the List Button Control Items dialog box.

The dialog box displays the appropriate fields, if they are not already visible.
2. Enter a name for this Launch item.

Be sure the name clearly describes the action to be taken; this is the text the viewer will see when
choosing an option from the list.

3. Enter into the Command Line field the name (including extension) of the program file for 
launching the application, and a document filename. 
If the program files will be in the same directory on every machine where the published 
presentation is viewed, include the full path with the filename. Include a path for the document file
only if it is different from the program file path. For example:

C:\WIN\EXCEL\EXCEL.EXE    SALEDATA.XLS
If the program files might be in different directories on the machines where the published 
presentation is viewed, enter only the filenames here. For example:

EXCEL.EXE    SALEDATA.XLS
IMPORTANT: If you omit the path, be sure that each machine where the published presentation is
viewed contains the path to this file in its search path. Otherwise, Open!Info Reader cannot 
launch the application.

4. Enter into the Working Dir field the full path of the directory where files for this application are 
stored, if it is different from the Command Line directory.

See Also:
List Button Controls
List Button Movement Item
List Button Behavior Item



Keyboard Shortcuts

You can choose menu commands with keys, instead of the mouse. Additionally, Open!Info Manager 
offers key combinations (keyboard shortcuts) that can be used as you work to execute a command 
without opening the menu.

To operate a menu from the keyboard, 
1. Press the ALT key followed by the letter underlined in the menu name. 

For example, to access the File menu, press ALT+F. 
2. Select a command in one of the following ways.

o Press the up and down arrow keys until the desired command is highlighted, then press 
ENTER.

o Press the letter underlined in the command name, such as O for Open.
Many actions also have special shortcut keys assigned.

Action: Shortcut:
Start a new presentation CTRL+N
Open a presentation CTRL+O
Save a presentation CTRL+S
Preview the open presentation F4
Preview starting with the 
current page SHIFT+F4
Display Presentation Properties CTRL+R
Select All controls CTRL+A
Copy selected control(s) CTRL+C
Cut selected control(s) CTRL+X
Paste control(s) from 
the Clipboard CTRL+V
Paste Shared control(s) 
from the Clipboard CTRL+J
Delete selected control(s) DEL
Undo last action performed CTRL+Z
Redo last action that 
was Undone CTRL+Y
Control Properties for the 
selected control(s) CTRL+K
Help for the current topic CTRL+F1
Help Contents F1
Toggle movement links F2
Movement links off SHIFT+F2
Movement links for 
selected page(s) CTRL+F2
Movement links for all pages ALT+F2
Open Preferences dialog box CTRL+F10
Summary window F5
Diagram window F6
Add a page F7
Modify a page SHIFT+F7
Delete a page ALT+F7
Page Properties CTRL+G



Add a template F8
Modify a template SHIFT+F8
Delete a template ALT+F8
Template Properties CTRL+F
Import media CTRL+F9
Media Properties CTRL+Q
Select Mode CTRL+E
Link Mode CTRL+L
Movement Button Control CTRL+M
Display Media Control CTRL+D
Behavior Button Control CTRL+B
Player Button Control CTRL+P
Text Overlay Control CTRL+T
List Button Control CTRL+I
Launch Button Control CTRL+H



Media Formats

Open!Info Manager supports a wide variety of data formats, so you can use media from almost any 
popular graphics, animation, video, or sound application. If you already have media files in another 
format, consider converting them to a supported format. Many applications offer the option to save 
data in a different format.

You can view other formats, as well, by creating a Launch Button Control to launch another Windows 
application from within Open!Info Manager.

The following formats are supported.

Video Formats
AVI video that runs under Video for Windows
AVS video for the ActionMedia II board, or equivalent
MOV QuickTime™ for Windows Movies
MPG Motion Picture Experts Group (MPEG)

Graphic Images
BMP Windows Bitmap (Open!Info is optimized to display BMP 

images most rapidly)
DCX Multiple PCX image format
DIB Device Independent Bitmap
EPS ** Encapsulated Postscript with preview
GIF Graphics Interchange Format (non-interlaced only)
IMG IBM GEM image format (black and white only)
JPG JFIF (JPEG File Interchange Format)
PCX ZSoft PC Paintbrush bitmap
RLE Run Length Encoding bitmap
TGA Truevision TARGA format
TIF Tagged Image File format
WMF ** Windows Metafile 
WPG ** WordPerfect Graphics file format 

** Support for these formats varies according to whether the file 
contains raster or vector layers, and what options you select when 
saving the file in this format. If the display in Open!Info Manager 
does not meet your needs, try selecting different options, or 
converting the file to a different format. 

Animation Formats
FLC Autodesk Animation File Format
FLI Autodesk Animation File Format

Sound Formats
MID Musical Instrument Digital Interface (MIDI)
RMI RIFF (Resource Interchange File Format) MIDI Format
WAV Sound

Text Formats
TXT ASCII Text (less than 64KB in size)

Moving Controls

You can move a control to a new position graphically while in the Select Mode. This lets you see the 



effect as you move the control box.
1. Activate the Select Mode.
2. Place the pointer anywhere in the control box, then press and hold the mouse button.
3. Drag the mouse until the control box is in the correct position.

The status bar displays the position as you drag.
Note: You cannot move a global control in the Page window.

Another way to move a control is to enter a precise pixel position for the upper left corner of the 
control box in the Properties dialog box.

See Also:
Movement Button Properties
Display Media Properties
Behavior Button Properties
Player Button Properties
Text Overlay Properties
List Button Properties
Launch Button Properties



Cut Command

Use the following procedure to cut controls from the page    or template and save them for future use.
1. Activate the Select Mode.
2. Select one or more controls.
3. Choose Cut from the Edit menu, or click the Cut tool on the toolbar, or press CTRL+X.

This removes the selected control(s) from the template and places them onto the Clipboard. Use 
the Paste or Paste Shared command to place the controls into another page or template.

See Also:
Copy Command
Include Control Command



Copy Command

Use the following procedure to copy controls to the Clipboard and leave the original in place.
1. Activate the Select Mode.
2. Select one or more controls.
3. Choose Copy from the Edit menu, or click the Copy tool on the toolbar, or press CTRL+C.

This places a copy of each selected control onto the Clipboard. The original controls are 
unchanged. Use the Paste or Paste Shared command to place the controls into another page or 
template.

See Also:
Cut Command
Include Control Command



Paste Command

Paste places the control(s) that are currently on the Clipboard onto the active template or page, in the
same location as the original. Each pasted control is given a new control name that is unique within 
the presentation. You can then modify the control properties as needed for this new location. 

Paste the Clipboard contents onto the active template or page in one of several ways.
o Choose Paste from the Edit menu or popup menu.
o Click the Paste tool on the toolbar.
o Press CTRL+V.
Behavior Button Controls and Player Button Controls both involve links to Display Media Controls. 
When you paste one of these controls onto a page or template, Open!Info Manager deletes all links 
unless the linked Display Media Control is pasted at the same time, or has already been pasted on 
the template with the Paste Shared or Include Control command.

However, on a template the associated Display Media Control may have already been copied to the 
new template with the Paste Shared or Include Control command. If so, the link is retained when the 
Behavior Button or Player Button Control is pasted into the template.

See Also:
Cut Command
Copy Command



Paste Shared Command

Paste Shared places the contents of the Clipboard onto the active template while maintaining a 
special relationship between the original and the copy. All properties are identical for both controls. If 
you change any property (such as the size or position) for one, that property automatically changes 
for the shared copy, as well.

Paste Shared is available only in the Template window for controls that were cut or copied from a 
template window. You cannot use Paste Shared to place a control onto an individual page.

Paste Shared the Clipboard contents into the active template or page in one two ways.
o Choose Paste Shared from the Edit menu or popup menu.
o Press CTRL+J.
Behavior Button Controls and Player Button Controls both involve links to Display Media Controls. 
When you use Paste Shared to paste a Behavior Button or Player Button Control on a new template, 
Open!Info Manager deactivates all links, with two exceptions. The links remain active if:
o The linked Display Media Control is pasted at the same time.
o The linked Display Media Control has already been placed on the new template with the Paste 

Shared or Include Control command.
The inactive links will be reactivated if the associated Display Media Control is later pasted on the 
same template with the Paste Shared or Include Control command. 

See Also:
Cut Command
Copy Command
Paste Command



Include Control Command

At times you may want to use a control that matches one you created for a different template that is 
not currently open. Rather than recreating the control, or opening its template to select and copy it, 
you can use the Include Control command.

Include Control is similar to Paste Shared, except that it lets you choose any global control from the 
presentation rather than using a control on the Clipboard. Like a control placed with the Paste Shared
command, an included control maintains a special relationship with the original; all properties are 
identical for both controls. If you change any property for one, that property automatically changes for 
the other as well.
1. Open the template where you want to include an existing control.
2. Choose Include Control from the Edit menu or popup menu.

A selection dialog box lists all controls created for templates in this presentation, except those 
already on the open template.

3. Select one or more controls from the list.
4. Choose OK.

Open!Info Manager places the selected controls onto the current template. They are identical to 
the original control, sharing all the same properties. Any changes you make to the newly included 
control automatically alter the original, and vice versa.

Behavior Button Controls and Player Button Controls both involve links to Display Media Controls. 
When you use Include Control to copy a Behavior Button or Player Button Control on a new template,
Open!Info Manager deactivates all links, with two exceptions. The links remain active if:
o The linked Display Media Control is included at the same time.
o The linked Display Media Control has already been placed on the new template with the Paste 

Shared or Include Control command.
The inactive links will be reactivated if the associated Display Media Control is later pasted on the 
same template with the Paste Shared or Include Control command. 

See Also:
Cut Command
Copy Command
Paste Command



Copying Media Files

Media files are stored on the hard disk or on the network file server, outside the Open!Info Manager 
database. Importing a media file creates a media object that contains a descriptive object name and 
information about the actual media file.

When you load a backup file into the database, you need to be sure its media files are in the 
appropriate directories. If they are not, you cannot display the media within Open!Info Manager. If you
have copied the backup file to a different machine that does not have the right directory structure, 
create the necessary directories and place the media files in them. Refer to the media list file to 
determine the correct files and directory structure.

See Also:
Creating a Backup File



Media List File

When you create a backup file, Open!Info Manager can also create a text file listing the name and 
directory path for each media object in the associated backup file. See the Preferences dialog box to 
choose whether the media list file is created.

Use this list to determine which media files should be backed up or copied to another machine along 
with the presentations in the backup file. It also helps you copy the files to the proper directories on 
the other machine.

The media list is placed into a text file in the same directory and using the same name as the backup 
file, but with .TXT as the extension. So, if you create a backup file called MYPRES.OIM, the 
associated media list file is called MYPRES.TXT.

The first section identifies the paths where Open!Info Manager generally expects to find the various 
media files. There may be multiple paths for any type of media file. These paths are set in the OIM.INI
file.

Base paths set in the OIM.INI file.
<animation path> = C:\oim\media\playable
<sound path>     = C:\oim\media\playable
<image path>     = C:\oim\media\image
<text path>      = C:\oim\media\text
<video path>     = C:\oim\media\playable

The second section lists the names of all media files referenced in the backup file. Each media file is 
preceded by either a full (absolute) path or the path identifier (such as <video path>) from the OIM.INI
file. 

A full path includes the drive and directories to the file, such as C:\VIDEO\MYVID.AVI. Full paths are 
used for media files stored outside the suggested Open!Info Manager directory structure. 

Copy the media file from the specified directory to an identical directory on the machine where the 
presentation is transferred. Using the previous example, you might have to create a C:\VIDEO 
directory before copying MYVID.AVI into it.

Media files stored in the media directories from the OIM.INI file are preceded with a path identifier, 
such as <video path>. The identifier refers to an entry at the top of the file. To locate these files, start 
with the appropriate path from the top of the file and follow with the path shown in the list. In this 
example, suppose you want to locate the file listed as:

<video path>  mypres\myvid.avi
Simply replace <video path> with the path identified at the top of the file. In this example, the full path 
would be:

c:\oim\media\playable\mypres\myvid.avi
If the OIM.INI file has multiple paths for the different media types, see Multiple Paths When Moving 
Media Files for help in finding the file and copying it to a new machine.



Multiple Paths When Moving Media Files

If the OIM.INI file contains multiple paths for the different media types, it may take some effort to 
locate the media file you want to copy to a new machine, and be sure it is copied to the proper 
location.

For example, suppose the video path is:
<video path>= c:\oim\media\playable;c:\video

In this case, you may have to check all the possible paths to locate the media file. If an entry in the 
media list file shows:

<video path>  mypres\myvid.avi
The MYVID.AVI file will be found in either of the following paths:

c:\oim\media\playable\mypres\myvid.avi
c:\video\mypres\myvid.avi

If you are transferring the media from the OIM.INI paths to another machine, you must place these 
files into the directories where that machine expects to find them. 

First view the OIM.INI file on the destination machine with a text editor, such as Microsoft Notepad. 
Locate the appropriate path entries in the Paths section of the file, and copy the media files into that 
directory structure. 

Continuing the example above, suppose the destination machine has the following video path:
d:\dev\video

The video to be transferred is in the MYPRES directory under the video path on the source machine:
<video path>  mypres\myvid.avi

So you would create a MYPRES directory under the video path on the destination machine, and place
MYVID.AVI into it.

d:\dev\video\mypres\myvid.avi
If the destination machine lists multiple paths in the OIM.INI file, you can create the MYPRES 
directory under any of those paths.



Undo and Redo Commands

Open!Info Manager keeps track of most actions you take when you are working with controls. Some 
other kinds of actions are tracked as well.

Use Undo to cancel the last action performed. Choose Undo multiple times to undo preceding actions
in sequence. You can Undo up to 10 actions in sequence. 
o Choose Undo from the Edit menu or a popup menu.
o Click the Undo tool on the toolbar. 
o Press CTRL+Z.
Use Redo to reinstate the last action that was canceled with Undo. Choose Redo multiple times to 
redo the previously Undone actions in sequence. You can Redo up to 10 actions in sequence.
o Choose Redo from the Edit menu or a popup menu.
o Click the Redo tool on the toolbar.
o Press CTRL+Y.
Some actions have such a comprehensive impact on the database that they actually clear the 
Undo/Redo lists. See Actions that Clear the Undo List.

Some actions are not tracked, and therefore cannot be canceled or reinstated with the Undo and 
Redo commands. See Untracked Actions.



Actions that Clear the Undo List

The following actions have such a comprehensive impact on the database that you cannot Undo 
them, or any actions taken prior to them.
o Creating a new presentation (File/New command)
o Saving a presentation (File/Save and File/Save As commands)
o Copying a template from another presentation (Template/Include command)
o Creating a new page or template (Page/Add, Page/Insert, and Template/Add commands)
o Deleting a page or template (Page/Delete, and Template/Delete commands)
o Clearing the database (File/Clear All command)



Untracked Actions

The following actions are not tracked, and therefore cannot be canceled or reinstated with the Undo 
and Redo commands. 
o Opening or deleting a presentation (File/Open and File/Delete commands)
o Opening and closing windows (Page/Modify, Template/Modify, Window/Summary and 

Window/Diagram commands)
o Most actions taken in the Summary window and Diagram window (with the exception of moving a 

page in the Diagram window, which can be Undone)
o Importing, viewing, and deleting media (Media/Import, Media/View, and Media/Delete commands)
o Setting Preferences (Properties/Preferences command)
o Setting Presentation or Media Properties (Properties/Presentation and Properties/Media 

commands)
o Previewing a presentation (File/Preview command)
o Publishing a presentation (File/Publish)
o Creating and loading backup files (File/Create Backup and File/Load Backup commands)



Searching for Text

Depending on your settings in the Presentation Properties dialog box, a viewer may be allowed to 
search for specific words in a Display Media Control that displays a text file.
1. Place the pointer over the Display Media Control that shows a text file.
2. Right-click to display the Text Search dialog box.
3. Enter the text you want to find in the Text field.
4. Choose a direction (Up or Down) for the search.
5. Choose the type of search you want to perform:

Fuzzy finds exact matches and words that are generally similar to your entry.
Exact finds exact matches only.

6. Choose the Find button to go to the first occurrence of your text (or similar text).
The Text Search dialog box remains open. Click Find again to move to the next occurrence of the
text.

7. Choose Cancel to close the dialog box when you finish searching.
See Also:
Previewing a Presentation



The OIM.INI File

The OIM.INI file is created the first time you run Open!Info Manager. It stores important information 
relative to running Open!Info Manager, such as your Preference settings and default settings for 
various features. By storing this information in the OIM.INI file, Open!Info Manager is able to retain 
your settings from session to session.

As you work, certain changes you make affect settings in the OIM.INI file automatically. For example, 
whenever you change the page width and height in the Presentation Properties dialog box for a new 
presentation, those settings are stored in the OIM.INI file as defaults for the next new presentation.

Other settings in the OIM.INI file are defaults which you can change manually. For instance, the 
number of actions you can Undo or Redo is set to 10 by default. You can change that number by 
editing the OIM.INI file.

To change the OIM.INI file, edit it with an ASCII text editor, such as Windows Notepad. The file must 
be saved in ASCII format, as well. Changes you make in the OIM.INI file take effect the next time you 
start Open!Info Manager. If needed, you can exit Open!Info Manager and restart right away, to 
activate the changes.

Additionally, an OIR.INI file is created to contain settings for Open!Info Reader, the royalty-free 
runtime program. This file contains settings that are appropriate to viewing presentations.

Open!Info Manager is designed so that changes to the OIM.INI file are usually unnecessary. 
However, if you are an experienced Windows user, you may want to become familiar with its settings 
and options. Refer to the Open!Info Manager User's Guide if you need to modify this file.



Select All Command

Use the Select All command on the Edit menu to select all controls in the active page or template at 
one time. When the controls are all selected you can move or resize the controls proportionally, or 
use other Edit menu commands to work with the selected controls.

See Also:
Select Mode



Viewing Media

Open!Info Manager lets you view any media file to help determine whether it is appropriate for your 
presentation. Choose View from the Media menu, then choose an option from the submenu.

Imported lets you view media that has already been imported into the database.
Other lets you view media that has not yet been imported into the database.

See also:
Media View Window



Control Properties

You can access the Properties dialog box for any existing control quickly and easily. Either double-
click the control box, or follow these steps:
1. Select the control whose properties you want to review or change.
2. Choose Control from the Properties menu, or choose Control Properties from the popup menu.
See Also:
Movement Button Properties
Display Media Properties
Behavior Button Properties
Player Button Properties
Text Overlay Properties
List Button Properties
Launch Button Properties



Transitions

Transitions are different ways of drawing a page to give the impression of direction and motion as the 
presentation moves from one page to the next. Use the Transitions dialog box to choose from 20 
effects, and to control how they are implemented.

The Transitions dialog box appears when you choose the Transitions button in either the Page 
Properties or the Template Properties dialog box.

Effect determines how the page is drawn on the screen. Choose from a list of 20 different effects.
Direction determines the direction from which the page is drawn. Choose Random to have 
Open!Info Manager change the direction each time. Other options vary, depending on the effect 
selected. Try different settings to determine which works best for a particular page.
Speed indicates the time delay between drawing segments of the page. Optimum uses the 
speed that has been selected as working best in combination with the selected Effect and the 
Optimum Granularity setting. Other options range from No Delay (0 millisecond delay) to Very 
Slow (250 millisecond delay).
Note: The actual speed for drawing a page is determined by a combination of the Effect, Speed, 
and Granularity settings. Some effects are inherently faster than others. Additionally, the coarser 
the granularity, the faster the page draws.
Granularity indicates the size of each segment during the effect.

Optimum uses the granularity that has been selected as working best in combination 
with the selected Effect and the Optimum Speed setting.
Very Fine draws segments one pixel in width or height.
Fine draws segments two pixels in width or height.
Medium draws segments four pixels in width or height.
Coarse draws segments eight pixels in width or height.
Very Coarse draws segments 16 pixels in width or height.

OK accepts the transition and closes the Transitions dialog box. The Page Properties or the 
Template Properties dialog box returns.
CANCEL discards any changes and closes the Transitions dialog box. The Page Properties or 
Template Properties dialog box returns.



Transition Effects

Open!Info Manager offers a choice of 20 different transition effects for displaying the pages of your 
presentation. The Effects list in the Transitions dialog box gives you the following options:

No Transition creates no transition between pages. Each page simply appears in place of the 
previous page.
Random draws a different transition each time you change the page.
Crush draws opposite edges of the page first, and moves toward the center. (This is the opposite
of Split.)
Diagonal draws from one corner toward the diagonally opposite corner.
Drip draws one row at a time while dripping its colors to the opposite end of the page.
Explode draws the page in four quadrants.
Grow Lines builds the picture from one edge by drawing several lines across the screen. 
Interleave draws alternate lines from two edges until they cross over and fill in the entire page.
Pieces draws small pieces of the picture in a random pattern until the entire page is drawn.
Sand draws colors across the screen to build the page from the opposite end.
Slide moves the entire page across the screen from one edge, while sliding over the top of 
previous page.
Slide Blind draws lines across the screen, then gradually fills in the space between them to draw
the full page. (This is similar to Venetian Blind.)
Slide Push moves the entire page across the screen from one edge while pushing the previous 
page out of the way.
Slide Weave draws lines from opposite sides of the page, dragging the picture across until the 
lines overlap to draw the entire page. (This is similar to Weave.)
Snake draws a line across the page in one direction, then back in the other direction, building the 
page from one edge to the other.
Spiral draws a line around the screen, gradually building the page from the edges or from the 
center.
Split draws a line down the center and draws out to both edges. (This is the opposite of Crush.)
Venetian Blind draws lines across the screen, then smoothly fills in between them to draw the 
entire page.
Weave draws lines from opposite sides of the page, building the picture as the lines overlap to 
draw the entire page. (This is similar to Slide Weave.)
Wipe paints the page across the screen starting from one edge.



Media View Window

The View command on the Media menu lets you select one or more media files to be viewed. Open!
Info Manager displays each selected media object in a separate media view window. 

The window size is determined by the size of the media being displayed. If you resize the window, the
media stretches or shrinks to fit the window. If the media is playable (video, animation, or sound), it 
plays through from beginning to end.

Note: If you are working with windows maximized, the media view window is maximized as well. You 
may need to reduce the window size to view the media.

Double-click anywhere in the media view window to display the Media Properties dialog box for the 
active media object (available only for imported media). You can also right-click in the window to 
access a popup menu with the following options:

Media Properties displays the Media Properties dialog box for the active media object. This is 
the same as double-clicking in the view window.
Replay is dimmed unless the media is playable: animation, sound, or video. Choose this option to
replay the media from the beginning.
Original Media Size restores the media view window to a size that is appropriate to the media 
file. This option is dimmed if the media view window has not been resized.

Press ALT+F4, or double-click the control menu box in the upper left corner to close the media view 
window.

NOTE: If you plan to view video or sound media objects, consider setting up the volume controls that 
came with your sound card so that you can control the volume during the preview. Refer to the sound 
card documentation for details.



Aligning Controls

Select one or more controls, then choose Align from the Edit menu, or from the Edit submenu on the 
control's popup menu. This displays the Align Controls dialog box where you can align controls to 
each other or to the edge of the page or template. (You cannot align global controls in the Page 
window.)

Choose one option for horizontal alignment and one option for vertical alignment.
No Change leaves the controls at their current position in the selected direction.
Left Sides moves the controls so that all align with the left side of the selected control that is 
farthest left. If only one control is selected, it is moved to the left side of the page or template.
Right Sides moves the controls so that all align with selected control that is farthest right. If only 
one control is selected, it is moved to the right side of the page or template.
Tops moves the controls so all are aligned with the top of the highest selected control. If only one 
control is selected, it moves to the top of the page or template.
Bottoms moves the controls so all are aligned with the bottom of the lowest selected control. If 
only one control is selected, it moves to the bottom of the page or template.
Centers moves controls to the horizontal or vertical center of the rectangular area defined by the 
selected controls. This option is dimmed if only one control is selected.
Space Equally moves the controls vertically or horizontally until all are equally spaced within the 
rectangular area defined by the selected controls. This option is dimmed if only one control is 
selected.
Center on page moves the selected controls to the center of the page. If multiple controls are 
selected, they are drawn in layers. Use the Bring to Front and Send to Back commands to 
determine which control is drawn on top.

Choose OK to accept your selections and close the Align Controls dialog box. Open!Info Manager 
moves the controls to their new position.



Size Controls

Select one or more controls, then choose Size from the Edit menu or from the Edit submenu of the 
control popup menu. This displays the Size Controls dialog box, where you can resize controls to 
match each other, or to fill the page either horizontally, vertically, or both. (You cannot resize global 
controls in the Page window.)

Choose one option for horizontal size and one option for vertical size.
No Change retains the current size in the selected direction (horizontal or vertical).
Shrink to Smallest and Grow to Largest are available only when multiple controls are selected. 
All selected controls are resized to match the smallest or largest of the selected controls, in the 
selected direction.
Width of Page and Height of Page expand the controls to fill the page in the specified direction.

Choose OK to accept your selections and close the Size Controls dialog box. Open!Info Manager 
redraws the controls according to your selections.



Closing a Presentation

When you finish working with a presentation, you can close it and continue working in Open!Info 
Manager.

Choose Close from the File menu. Open!Info Manager gives you an opportunity to save changes to 
the presentation if they have not been saved already.



Publishing a Presentation

Publishing a presentation creates a separate directory structure containing all the files needed to run 
Open!Info Reader and view the presentation. If any AVI or MOV video files are included in the 
presentation, runtime versions of Video for Windows and/or QuickTime for Windows are placed into 
the directory structure, as well. TrueMotion-S drivers are included if the AVI or MOV files were 
compressed with TrueMotion-S.

Note: Please consult your license agreement for distribution and licensing rights to these programs.

Open!Info Manager publishes to an existing directory. Be sure to create the publishing directory, or to 
clear any unrelated files from it before you being the publishing process.
1. Choose Publish from the File menu.
2. Select one or more presentations from the selection dialog box.

Open!Info Manager verifies that any current changes must have been saved. If not, you are given
an opportunity to save and continue publishing. (If any selected presentation does not have a 
start page, a message indicates that publishing cannot be completed.)

3. Choose a directory path for the published presentation from the Select Path dialog box, and 
choose OK.
Open!Info Manager displays the Publishing dialog box as it compares the files to be published 
with any files already in the directory selected for publishing. To save time, Open!Info Manager 
does not copy any file whose date, time, and size is identical to a file already in the directory.
Any missing media files are reported at the bottom of the dialog box, and saved in a separate text
file, ERRORS.TXT, in the Open!Info Manager directory.

4. Review the information in the Publishing Summary that appears after the comparison is complete.
5. Choose Continue if there is sufficient space to publish. (If you choose Cancel, the entire 

publishing process is canceled. Copied files remain in the published directory, and you may need 
to delete them separately.)
Open!Info Manager displays a progress bar as it copies files to create the published directory 
structure.    If any missing files are listed, press the Continue button to continue publishing. You 
can add those files to the proper directories later.
This dialog box indicates what percent of the total amount being copied is represented by each 
file as it is copied. A progress bar indicates how much of the total publishing process is complete.
After the files are copied Open!Info Manager displays the Publishing Selected Presentations 
message box as it creates a published backup file. The Loading Objects into Database dialog box
appears as this backup file is loaded into the published database. 
If any messages appear in the Notes/Warnings/Errors list box, use the scroll bar to scroll through 
and review the messages before closing the dialog box. These messages are written to the same 
error file as the messages from the Publishing dialog box (step 3).

6. Choose OK, if needed, to close the Loading Objects dialog box when the database is fully 
loaded. This dialog box closes automatically if no messages are shown.

7. Choose OK in the message box that indicates publishing was completed.
10. Review the error file if any problems were reported, and correct the problems.

Place any missing media files into the appropriate subdirectory of the published MEDIA directory. 
If other problems were encountered, refer to the User's Guide, for help in correcting them. If 
needed, publish the presentation(s) again after correcting the problems.

11. Test the published presentation.



Publishing Summary

The Publishing Summary shows information comparing the amount of space required to publish and 
the amount of space available. The space required to publish will be different from the final published 
size if some files already exist in the publishing directory.

Choose Continue if there is sufficient space to publish and you want to continue. Choose Cancel to 
cancel the publishing process.



Published Directories

Open!Info Manager creates a directory structure based on the directory you selected for publishing. 
Depending on the size of the presentation being published this may take a few minutes. This structure
contains:
o Open!Info Reader files.
o Presentation media files.
o Setup program for Open!Info Reader and presentation media.
o Runtime versions of Video for Windows and QuickTime for Windows, if needed.
The Open!Info Reader Setup program is stored in the publishing directory. The following directories 
are created below the publishing directory.

PROGRAM contains the Open!Info Reader program files and a database containing only the 
published presentations.
MEDIA MEDIA contains separate subdirectories for different types of media: IMAGE, PLAYABLE, 
and TEXT. Publishing does not reproduce the directory structure used to store media during 
authoring. Rather, separate subdirectories are created for each published presentation below the 
IMAGE, PLAYABLE, and TEXT directories.

Other directories are created as needed, based on the video file types contained in the published 
presentations.

VFW contains the Video for Windows runtime files for AVI video file playback. It also contains a 
Setup program to install or update Video for Windows for viewing the published presentation. This
directory is created whenever published presentations include AVI video files that are not 
TrueMotion-S (such as Indeo).
VFWTMS contains the Video for Windows runtime files and the TrueMotion-S decompressor for 
AVI video file playback. It also contains a Setup program to install or update Video for Windows 
and the TrueMotion-S decompressor for viewing the published presentations. This directory is 
created only if the published presentation contains TrueMotion-S AVI video files.
QTW contains the QuickTime for Windows runtime files for MOV video file playback. It also 
contains a Setup program to install or update QuickTime for Windows for viewing the published 
presentation. This directory is created whenever published presentations include MOV video files 
that are not TrueMotion-S (such as Cinepak).
QTWTMS contains the QuickTime for Windows runtime files and the TrueMotion-S decompressor
for MOV video file playback. It also contains a Setup program to install or update QuickTime for 
Windows and the TrueMotion-S decompressor for viewing the published presentations. This 
directory is created only if the published presentation contains TrueMotion-S MOV video files.



Test the Published Presentation

You should test the published presentations before distributing them to viewers.
1. Exit Open!Info Manager by choosing Exit from the File menu.

You cannot run the published Open!Info Reader while Open!Info Manager is open.
2. Choose Run from the Program Manager File menu.
3. Use the Browse button to select OIR.EXE from the published PROGRAM directory, such as OIM\

PUBLISH\PROGRAM.
4. Choose OK in the Run dialog box to run the published version of Open!Info Reader.

If you published only one presentation, it begins immediately. If you published multiple 
presentations, a dialog box allows you to choose a presentation to view.

5. View the presentation.
6 If any errors are encountered, the publishing process cannot be completed. The Publishing 

message box remains open. Go to step 7. If there are no errors, proceed to step 9.
7. Review the messages in the Errors list if there are any, then choose Cancel to close the 

Publishing message box.
8. Correct the errors, then publish the presentation(s) again, if errors were encountered.
9. Distribute the published directories .



Distributing Published Presentations

After presentations have been published in Open!Info Manager, you need to place the data on some 
distribution media, such as a removable hard disk or CD-ROM. At the viewing site, you need to install 
Open!Info Reader with the presentations. This will create a Windows program group with the Open!
Info Reader icon.

Open!Info Manager provides a Setup program that installs the Open!Info Reader program, as well as 
the published database and media files. Additionally, the Open!Info Reader Setup program will direct 
you to run the Video for Windows Setup program if the presentations contains AVI files, and the 
QuickTime for Windows Setup program if the presentations contains MOV files. The message 
displays the location of these Setup programs.

Note: Be sure to run these Setup programs, even if Video for Windows or QuickTime for Windows is 
already installed on the machine. These Setup programs update them with the latest video drivers.

For detailed instructions on setting up the viewing site, see the Open!Info Manager User's Guide.
See Also:

Publishing a Presentation



Select Path for Publishing

The Select Path dialog box is used to choose a path for the published presentation. The first time you 
publish it displays the default path, PUBLISH under the Open!Info Manager directory (example OIM\
PUBLISH). Subsequently, it displays the last publishing path used.

Choose a different path by clicking the appropriate names in the Drive and Directory lists. Move to a 
previous directory by clicking [..] in the Directory list. Alternatively, you can enter the first letter of the 
desired drive or directory after moving to its list box. 

The currently selected path appears above the directory list box. Choose OK when the correct path 
appears above the Drive list.

Open!Info Manager requests confirmation of the selected path. If a presentation was previously 
published to this path, you are asked to confirm that you want to publish to the same directory. 

Note: You cannot publish to the same location where Open!Info Manager is installed.

See Also:
Publishing a Presentation



Template

A template provides a foundation for multiple pages that are similar in appearance. Use a template to 
select a transition, background image, or automated page sequence for multiple pages. Controls you 
create on a template are global controls that display media or define buttons for all pages referencing 
the template.



Page

A page is the individual screen that displays media to communicate your message and buttons for 
viewer interaction. Each page can have a transition, a background image, and an automated page 
sequence assigned to it. The media and buttons are defined as controls. 

If multiple pages share certain elements, such as a transition or background, create a template with 
those shared elements. Then you can attach that template to any page, making it much faster to define 
the page. 



Page Window

The Page window provides the tools to create and modify pages. You can assign page properties, as 
well as define controls.



Template Window

The Template window provides the tools to create and modify templates. You can assign template 
properties and define global controls.



Presentation

A presentation is a collection of pages, templates, controls and media that will be presented to a viewer.
It combines video, sound, images, animation, and text to communicate a message.



Control

A control defines an area where media is displayed, or a button the viewer can click to perform some 
action. There are seven types of controls: Movement Button, Display Media, Behavior Button, Player 
Button, Text Overlay, List Button, Launch Button, each designed to perform a different function.



Database

Open!Info Manager's database stores everything you create for a presentation as a separate entity, or 
object, in the database. Every page, template, display area, and button is a separate object. Media is 
not stored directly in the database. To save disk space, the database stores media object, which is a 
link to the actual media files.

The database manages these objects, and makes them available as you create presentations.



Backup File

A backup file is a file outside the database that contains copies of one or more entire presentations, 
selected media objects, or all the contents of the entire database. This file can be stored as protection 
against data loss, used to transfer the presentations or media objects to a different machine, or as 
backup for presentations you are not actively working on.



Global Control

If a page has a template attached, the Page window displays all the controls from that template. These 
are called global controls.

Global controls cannot be resized or repositioned in the Page window. The only way to modify the size 
and position of a global control is to modify the template itself, which will affect all other pages that have
the same template attached. 

Some global controls are appropriate for the page as they were defined in the template. For example, a 
global exit button is often complete and does not need any change for individual pages. Other global 
controls, however, may need to be modified for individual pages. These modifications are made within 
the Page window by modifying the control's properties.



Local Control

Local controls are controls that were originally created on a template (global control), whose properties 
are being reviewed or have been changed for a specific page. For example, a template Launch Button 
Control might be defined to launch HTI Sure!MAPS displaying a map of Europe. For one page, however,
you might choose to have that Launch Button Control display a map of Africa, instead.

You cannot move a local control, or change its size or button image settings. Only the control-specific 
properties can be overridden. Local controls are not affected by changes in the template, either. To 
return a local control to its global settings, remove the local properties.



Page Controls

Page controls are created within the Page window, and are unique to the page where they are created. 
You can create, modify and delete page controls as needed, without affecting any other page. You can 
copy page controls onto other pages, but not onto templates.



Media Object

Open!Info Manager does not store actual media files in the database. Rather, it stores media objects 
which contain key information about a media file, including the type of media, the directory where it is 
located, the filename, and the media size. Media objects can be assigned as backgrounds and can be 
assigned to illustrate individual controls.

In the database, media objects are stored separately and linked to each presentation that uses them. If 
you delete a page or presentation, the media object link is deleted but the media object remains in the 
database. This enables you to use the same media for multiple templates, pages, and presentations.



Object Names

When you create any object, Open!Info Manager assigns it a unique name, such as Page - 235 or 
Template - 150. The first part, of course, indicates the type of object, and the number is based on the 
number of objects currently in the database.

You can change any object name in the associated Properties dialog box. Open!Info Manager lets you 
give truly descriptive names by allowing up to 48 characters in all object names. Object names can 
include blank spaces and special characters, such as slash (/) and comma (,) which are not permitted 
in MS-DOS filenames. Object names cannot, however, be blank or contain only spaces, and cannot 
contain two exclamation points together (!!).



Placeholder

A placeholder is a media object that links the Open!Info Manager database to a media file that has not 
yet been placed into the proper directory. By creating placeholders, you can assign media to the 
presentation before that media has been developed. This lets you author the presentation and develop 
media simultaneously.




